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Chapter 1 | Introduction

Chapter 1 Introduction

Purpose of this document

This manual is written for anyone using OpenTouch Fax Center to send, receive or manage faxes.

g~ Note: It does not cover OpenTouch Fax Center server and client installation (see the Installation and
Maintenance Guide), and server configuration and management (see the Administration Guide).

Windows Tools

OpenTouch Fax Center offers several tools that can be installed and used on the Microsoft Windows
environment.

SendFAX

SendFAX is a fax interface that offers users all the functions involved in the sending of a fax (see chapter:
Overview on page 3).

SendFAX Local Phone Book

The SendFAX Local Phone Book is an application that allows you to locally manage your contacts for easy
selection in SendFAX. Any number of phone books can be created (see chapter: Local Phone Book Overview
on page 25).

g~ Note: Additionally to this local phone book application, the personal and public Web Phone Books can
be used from SendFAX (see Web Phone Books on page 2).

Viewer

The Viewer allows users to display and read faxes. It is actually a TIFF files viewer that offers some additional
editing features (see chapter: Overview on page 37).

Note: If you do not have the Viewer installed on your computer, you can use the Windows Imaging
Preview to view your faxes.

[ N

Fax Utilities for General Applications

OpenTouch Fax Center provides several utilities that allow you to send faxes directly from your general
applications. These can be printer drivers, used from any application by the print feature — or integrated fax
features for MS Office/Word — (see chapter: Overview on page 43).
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Chapter 1 | Introduction

Fax Utilities for Email Clients

OpenTouch Fax Center allows you to send and receive faxes with your email software. Also, if you are using
Microsoft Outlook — connected to an Exchange server — some additional tools are available to facilitate the
management of your faxes (see chapter: Faxing with Email Clients: Overview on page 51).

Cover Sheet Editor

Cover Sheet Editor allows to create fax cover sheets or modify the provided ones. A cover sheet can contain
variables that are resolved at send time — sender name, company name, address, telephone and fax numbers,
etc. — (see chapter: Overview on page 71).

Web Tools

OpenTouch Fax Center offers several tools that can be accessed by using a Web browser. All of them are
available through the same Web interface. For more information, please refer to the concerned chapter
(Overview on page 81).

Note: The OpenTouch Fax Center Web client interface is optimized for use with assistive technologies,

[ i
which are used by individuals that are visually impaired or have reduced mobility.

Fax Browser

The Web interface provides a means to view the status of your faxes in the Inbound History, Outbound History
and Outgoing Queue.

Web Compose

The Web Compose is the part of the Web interface where you can create and send faxes.

Web Phone Books

The Web Phone Books allow you to manage your personal contacts (and possibly view public contacts) that
can be used to address faxes from the Web Client — and optionally from SendFAX.

External Tools

Depending on the implementation performed by your administrator, you may be able to benefit from OpenTouch
Fax Center functionalities through several external clients (other than the ones provided along with the
OpenTouch Fax Center client installer).

Email Clients (for Faxing)

You may be able to fax through OpenTouch Fax Center by using your email client; email attachments are
then sent as fax pages. See Faxing with Email Clients: Overview on page 51.
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Chapter 2 | Faxing with SendFax

Chapter 2 Faxing with SendFax

Overview

SendFAX is the fax interface for users with advanced faxing needs. If Outlook has been configured on your
local machine, SendFAX can be integrated with Outlook.

This chapter includes information about configuring SendFAX and using it to send faxes with various options.

Launching SendFAX

Among your installed OpenTouch Fax Center applications, choose SendFAX.
The SendFAX interface will appear.

g~ Note: SendFAX can also be accessed through any Windows applications with a printing function (see
Faxing from Windows Applications by Using SendFAX on page 43) or from Microsoft Outlook by clicking

the @ button (if the Outlook add-in is installed on your PC).

Interface Description

Menus and toolbars aside, after initial installation the default SendFAX interface is divided into four main
areas:

8AL90087ENAA - Ed. 01 - August 2020 - OpenTouch Fax Center User Guide 3
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File Edit Yiew Thumbnail Preview Annctation Tools Help

Send E|| [m IDefauItEoverSheet j| ﬁ | ?

Recipiets: >

To... |

I |ﬁ| M ame | Compary | Destination
Carnpany: I &
Drestination: I

Subject: I

= 1- ;IHZ vI M 4 »p H|1DDZ v“E

2_ =
4 | »
RNEA=EYAE3=
Ready 112 lcap o [

1. The Manual Addressing Fields section — To, Company, Destination, and Subject — allow you to type
recipient information directly. Usually, To receives the recipient's name. Destination, which is the only
mandatory field of the four, receives the fax number or the email address.

2. The Recipients section displays the individuals and groups to receive the transmission, either selected
from a phone book or typed directly into the manual addressing fields.

3. The Thumbnail View section displays successively a reduced image of each page of the fax. A scrollbar
enables you to view any page; selecting a page in the Thumbnail View displays that page in the Fax
Preview. The Thumbnail View also makes it possible to reorder and delete pages from the fax.

4. The Fax Preview section displays a single page of the fax at a time. It is here that you add annotations
to a fax before sending it. For more details on annotations, see the corresponding chapter (Overview on
page 41).

Also, SendFAX provides the means:

+ to select a cover sheet among the ones available on the fax server,

» to display a contact list of potential recipients from one of several phone books available to you,
» to alter transmissions settings, modify your sender and recipient information,

» to change the interface to suit your requirements,
« to send faxes to fax numbers as well as to email addresses.

Menu Bar Details and Associated Icons

Description of all the items of the SendFAX menu bar.

The File Menu

New cancels the current fax, clearing the fax recipient list and begins a new one.
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Chapter 2 | Faxing with SendFax

0 Insert lets you insert a file into your fax.
Save As lets you save your fax in a local or network directory.
Print prints the fax and any cover sheet.
Send sends the fax and closes the SendFAX interface.
Send without Closing sends the fax but keeps the SendFAX interface open, for example, to allow you
to send the same fax to other recipients.
Connection Settings allows you to change the Fax Server Host Name and other parameters. For more

details refer to Connection Settings on page 8.

User Settings

allows the user to change his User Name and Password. For more details, refer
to Connection Settings on page 8. This option is only available in native mode
(when sending through an XML gateway),

Email Settings

allows the user to set up the SMTP settings and email content (used by the email
feature of SendFAX). For more details refer to Email Settings on page 10.

Exit closes SendFAX.
The Edit Menu
E1  Faxing Properties displays a tabbed window in which you enter sender information or organization

information and specify fax settings. For additional details refer to Editing sender
or company information on page 19 and Changing fax transmission settings on

page 20.
Fax Recipient allows you to modify the information about a selected fax recipient in the fax
recipient list.
Cover Sheet Comments enters a comment in the cover sheet.
Printer Properties lets you configure the OpenTouch Fax Center printer.

The View Menu
Toolbar displays the SendFAX toolbars. When a toolbar is visible, a check mark appears beside its
name. The four toolbars; Main, Preview, Thumbnail, and Annotation; are displayed by default.
Status Bar displays or hides the Status Bar. A check mark appears beside it when it is visible.
Phone Book displays a phone book section on the right or left of the interface.

Full Preview

displays only the thumbnails and fax preview. The display of the manual addressing fields, the
fax recipient list, and the contact information is suspended. Deselecting Full Preview re-displays
that information in the SendFAX window.

Options displays a window that allows to:
» select the phone books you wish to integrate with SendFAX (see Phone Book Integrations
on page 11).
» choose the default SendFAX interface to be launched via the FaxCenter virtual printer (for
more details, see SendFAX Interface Display Options on page 13)
Languages sets the language used in client applications for the current user (MMC Snap-in, SendFAX,

TIFF Viewer, Local Phone Book, and Cover Sheet Editor). Changes occur after restarting
SendFAX.
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The Thumbnail Menu

»® Delete removes pages selected in the thumbnail view from your fax.
Move [Fitst moves the selected page to the first page after a cover sheet.
Move [Up moves the selected page up one page
Move [CDdwn moves the selected page down one page
Move [Last moves the selected page to the last page of the fax
&) Mark As not instructs SendFAX to exclude the page selected in the thumbnail view when you
Send transmit the fax.
Mark As [Sdnd restores an excluded page.
m Zoom increases or decreases the magnification of pages in the thumbnail view.

The Preview Menu

7] First Page lets you view the first page of your fax.

4 Previous Page lets you view the previous page of your fax.

3 Next Page lets you view the next page of your fax.

M Last Page lets you view the last page of your fax.

O Best Fit displays the page at the magnification that best fits the preview window.

Fit to Width displays the page at the maximum width that fits in the preview window.

Fit to Height displays the page at the maximum height that fits in the preview window.
10z -| Zoom lets you choose one of the preset magnification values.

The Annotations Menu

Annotations are objects you can add to draw attention to certain parts of a fax. For more information about
annotations, refer to the corresponding chapter (Overview on page 41).

g~ Note: The Annotations feature cannot be used on cover sheets when composing a fax in SendFAX.

The Tools Menu

OpenTouch Fax Center launches your local phone book to manage contacts usable with SendFAX. See SendFAX
Local Phone Book Local Phone Book Local Phone Book Overview on page 25 for detailed information.

Note: Your OpenTouch Fax Center Web Phone Book can be managed through the
Web Cilent (see Web Phone Book on page 118).

The Help Menu

# Help Topics opens the online help, where you can get more information about using OpenTouch Fax
Center .
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About SendFAX displays version and copyright information about SendFAX.

Result of Fax Sending Depending on Destination Type

SendFAX allows you to send a fax to a destination that is either a fax number or an email address. When the
destination is a fax number, the behavior is like any other fax. When the destination is an email address, the
fax (with the cover sheet, if applicable) is sent as an attachment with the email. Email settings, including the
attachment format, can be configured here: Email Settings on page 10.

Depending on how SendFAX is configured to send faxes, you will have different behaviors for destinations
and sent fax records. For more information on configurations, see Settings on page 7.

SendFAX Configured to Fax via the Server's XML Gateway

In that configuration, regular faxes are directly sent to the fax server (via XML Gateway) and emails are sent
via a separate mail server.

When the destination is a fax number, the record of the sent fax will appear in the Outbound History folder
of the Web Client.

When the destination is an email address, the record of the sent email will appear in a . 1og file:
C:\Users\<user name>\AppData\Roaming\Fax\SendFAX\Trace\SendFaxEmail.log. You can open this
log with any text editing software.

SendFAX Configured to Fax via Outlook
In that configuration, faxes and emails are sent via Outlook to the appropriate server (fax/email).

When the destination is a fax number, the record of the sent fax appears in the Sent Items folder of Outlook
as well as in the Outbound History folder of the Web Client.

When the destination is an email address, the record of the sent fax appears only in the Sent Items folder
of Outlook.

Email Behavior With or Without a Cover Sheet

When a fax is sent to multiple fax numbers, a record is always kept for each fax destination whether there is
a cover sheet or not. The behavior when sending to email addresses is different.

When a fax is sent to multiple email addresses without a cover sheet, SendFAX creates only one email and
sends it to all recipients. The To: field of the email received by the recipients will contain the names of all the
recipients.

On the other hand, if the fax is sent with a cover sheet, SendFAX creates an email for each recipient and the
To: field will contain only the email of the recipient.

When sending to multiple email addresses while SendFax is not configured to fax via Outlook, a record for
each recipient is always created in the .log file, whether there is a cover sheet or not. In Outlook, a record is
kept only for each email that is sent.

Settings

In this section you will find the various settings that can be configured in SendFAX. Normally, these settings
are configured by the system administrator and the user should not have to configure or modify them.
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Connection Settings

If you need to modify your connection settings that were configured during initial installation, proceed as
follows:

1. From the SendFAX menubar, click File [_Cdnnection Settings.
The Account Information dialog box appears.

Account Information E3

— Fax Server Connection Settings

Host Mame or URL: IIncthnst

— SendFa will send its fakes through:

" Outlook [requires proper configuration of your Exchange server]

%' The fax server's XML Gateway interface [direct connection to the fax system)

< Back I IHeut » I Cancel | Help

2. In the Connection Settings section, specify the Host Name or URL.

A Attention: This value should have been correctly set (or communicated) by your administrator while
~ installing SendFAX; you should not have to change it.

» The name used to reach the on-premises Fax Server host.
Acceptable syntax: [{http|https}://] <ServerName or IP>[: <Port>]

In HTTPS context, <ServerName_or_IP> must be the Common Name of the Fax Server (and not its
IP address).

g~ Note: If you want to benefit from the Web Phone Book integration, you must ensure that the

entered URL will allow to reach the OpenTouch Fax Center Web Services (which use HTTPS by
default).

3. In the SendFAX will send its faxes through section, select the radio button that corresponds to your

desired settings:

Select Outlook if you want to use the SendFAX integration with Outlook. Outlook must already be

configured on the local computer and the administrator must have correctly configured the Microsoft
Exchange server of your organization.
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* In an on-premises deployment configuration: click Finish to finalize the configuration.
Note: To be able to send faxes to email addresses, no additional email configuration is required.
Outlook will automatically manage this.
+ Select The fax server's XML Gateway interface in order to use SendFAX in normal mode.

» In an on-premises deployment configuration: click Next and continue with User Settings with
On-Premises Deployment on page 9.

g~ Note: To be able to send faxes to email addresses, you must configure specific email settings
(see Email Settings on page 10).

User Settings with On-Premises Deployment

Continued from Connection Settings on page 8 for an on-premises deployment configuration.

User Settings il

rAuthentication
" Use Windows Integrated Single Sign-On

[ 150 st stor
I~ Get sender infarmation fram the active directan on startup

¥ |se Basic Authertication

IJser Name: IJnhn.Smﬂh@example.cnm

Password: I‘*“*“‘“"‘“1
¥ Remember password

r— Email corfimations should be sent to:

{” Do not send email confimations

¢ |se the email address associated with my account

" Use this email address:

<Back [ Fmsh | Cancel Hep |

1. In the Authentication section, select the radio button that corresponds to your desired settings:
+ Select Use Windows Integrated Single Sign-On to log in automatically with your regular NT identity.

Note: The check box, Get sender information from the active directory on startup, fills the
sender information with active directory information if the user selected the Use Custom Sender
& Company Information option in the advanced transmission settings. For additional details on
the latter, refer to the section, Editing sender or company information on page 19, found further
on in this chapter.

[

+ Select Use Basic Authentication, and enter your user login in the User Name field and password in
the Password field. If you want these values to be used every time you log on, check the Remember
password box.
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2. In the Email confirmations should be sent to section, select one of the options for the e-mail address
to which the feedback notifications are to be sent:

Option Description

Do not send email confirmations You will not receive any confirmation by email.

Use the email address associated with my account You will receive confirmations through the email address
associated to the account defined at the previous step.

e Note: This option is selected by default.

Use this email address You will receive confirmations through the email address
entered manually in the field beside.

3. Click Finish.

Subsequent SendFAX sessions will use the same settings. If the Remember password box wasn’t checked,
a password dialog will prompt you when sending a fax if required.

g~ Note: If there is a problem with the system when you try to log into SendFAX and an error message
appears, consult your system administrator to make sure you have the proper authorization, or to ascertain
when the system will be back and running.

If at any time you wish to change the gateway or modify the connection properties, perform the set-up procedure
once again as detailed above.

Email Settings

To access the Email Settings dialog box, click File ["Erhail Settings... in the SendFAX menubar.

Email Settings E3

—SMTP Settings

Mail Server: I MyMailServer

Sender Address: ' Use the email address associated with my account

™ Use this email address

—Email Conkent
Atkachment:  |PDF hd
Defaulk Message: d

a4 I Cancel | Help |
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SMTP Settings

If you intend to send faxes to email addresses (in addition to fax numbers), you will need to configure the
email settings. If you are configured to send your faxes through Outlook (see Connection Settings on page
8), the SMTP settings are already configured and cannot be modified in this dialog (the SMTP Settings box
is grayed out).

If you do not use Outlook and want to send faxes to email addresses through a mail server, configure the
SMTP settings.

A Attention: When sending faxes to email addresses (as opposed to fax numbers), the records for sent
~ faxes are not logged in the Web Client folders. See Result of Fax Sending Depending on Destination
Type on page 7 for more information.

Mail Server Specify the Mail Server. The administrator must have already correctly configured
the mail (SMTP) server of your organization.

Note: Acceptable syntax: <MailServerName or IP>[:<Port>]

|
By default, the port number is 25. You need to enter a port number only if you
use a different port.
Sender Address Select Use the email address associated with my account if you want SendFAX

to use your normal email as your return address. If you want a reply to a different
email address, select Use this email address, and supply a valid email address in
the input field.

Email Content

In this box you can select the format of the email attachment and write a default message.

Attachment When sending a fax to an email address, the fax is in the form of an attachment. You
can select PDF or TIFF as the format. The default is PDF.

Default Message Type in your default message. The message will be shown in the body of the email
only when there is no text in the cover sheet Comments field or when there is no
cover sheet.

Phone Book Integrations

How to select the phone books you wish to integrate with SendFAX, and how to display them in the interface.

1. Select the sources of your contacts:
a) In the menu bar, choose View [Options.

Show Mames Frorm...
¥ xhdediusFax Local Phone Book
¥ xhdediusFax web Phore Book
[T MAPI Address Book

b) Select the phone books that you wish to integrate with SendFAX (depending on your needs and on
your corporate environment):

OpenTouch Fax Center Local Includes all phone books that are available in your Local Phone Book
Phone Book application (see Local Phone Book Overview on page 25).
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OpenTouch Fax Center Web Phone
Book

Includes your personal Web Phone Book, as well as any public Web
Phone Book that may have been made available to you by your
administrator (see Web Phone Book on page 118).

g Note: The Web Phone Book integration requires that:

* The URL to the fax server — as specified in SendFAX connection
settings — allows to reach the Web Services (by default in
HTTPS).

* You are logged in using one of the following methods:

» Basic authentication using HTTPS
* SSO (connected to 1IS) using HTTP or HTTPS

(See Connection Settings on page 8)

MAPI Address Book

Includes the contacts that are stored in your Outlook (or any other email
application compatible with MAPI).

c) Click OK.
2. Select View [PHone Book, then choose Show Right or Show Left, depending on the display you wish
to obtain.
File Edit Wiew Thumbnail Preview Annotation Tools  Help
Send [F1 | 1] IN-:: Cover Shesat jl @ | ?
To I Selected phone book: Contact j
Compan: I Tupe name or zelect from lizt;
Destination: I | Mame / | Company | Destination |
Subject: I € Amy Howard 514-363-3633
T ﬁ Johin Smith Jo Corp, 514-987-6543
e ¥ x -~ € RobetPeppsr Boblnc 5141234567
|ﬁ| Mame | Company | Destination | &
Figure 1: The “Show Right” display
File Edit Wiew Thumbnail Preview Annotation Tools  Help
Send [F1 | 1] IN-:: Cover Shesat jl @ | ?
Selected phone book; I Contact j T I
Type name or gelect from list; I Compar; I
| Name ¢ | Company | Destination | Diestination: I
g Ay Howard 514-363-3693 Subject: I
John Smith Jo Corp. A14-587-6043 —
€  FRobetPepper  Boblnc. 514-123-4567 RisepiiEs 3 X -
@ |ﬁ| Hame | Company | Destination

Figure 2: The “Show Left” display

g~ Note: With the phone book displayed, you can hide or display the manual addressing fields (To,
Company and Destination) by using the ** or '™ button above the Recipients list.
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3. If you have more than one Phone Book source, you can display them alternately by using the Selected
Phone Book drop-down list.

4. If you need to remove the phone book section from the SendFAX interface:

a) Select View [PHone Book.
The current display selection appears checked in the sub-menu.

b) Select this checked item.
The Phone Book disappears from the SendFAX interface.

Note: This documentation assumes that phone book information is displayed on the right side of the
SendFAX interface.

SendFAX Interface Display Options

SendFAX can be used for composing faxes from scratch, as described in this chapter, but it can also be
launched from any Windows application by printing on a dedicated virtual printer named FaxCenter (see
Overview on page 43).

When launched via such a print, SendFAX will be displayed by default with the interface type that is selected
in View [COptions (SendFAX menu).

Opening SendFAX through the Fax Server virtual printer...
" Abways display basic interface

& Abways display full inteface

You can change this default according to your needs:

Option Description

Always display basic interface SendFAX will be displayed with the minimal interface required for quick
faxing (see details below).

Always display full interface SendFAX will be displayed with the full interface described in this
chapter (see Launching SendFAX on page 3).

Note: When accessed via the Windows Start menu, SendFAX will be always displayed with its full
interface.

[ N

Basic Interface Overview

The SendFAX basic interface includes a single field for entering the recipient fax number, which is the minimum
information required for sending a fax.

Recipient Fax Number: |

Advanced view | Send I Cancel |

Clicking Send will immediately send the fax to the specified destination.

The Advanced view (full interface) can however be displayed before sending the fax if you wish to benefit
from all other SendFAX features.
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Setting the default fax resolution for printing

To change the printer driver’s default resolution for faxes, proceed as follows:

oo bd-=

Choose Edit [Printer Properties.

Click the Paper/Quality tab.

Click on the Advanced button.

Set the printer driver's resolution in the Graphic-Print Quality field. Choices are Low(200x100),
High(200x200), Fine(300x300) or Ultra Fine(400x400).

At the next logon in SendFAX, the program will validate the printer driver resolution. If the printer driver

default resolution is higher than the maximum resolution allowed by the user profile, SendFAX sets it to
the latter.

. You can also choose different dithering algorithms though the Half-toning option. If you decide to use an

Error Diffusion algorithm, you can also adjust the intensity of the rendering.
This changes the printer resolution for the whole system, and remains so until it is changed again, using
the above procedure.

Sending a Fax

To send a fax using SendFAX:

1.
2.
3.

Launch SendFAX.

If needed, select a cover sheet and type a message in it (see Using Cover Sheets on page 14).

Insert one or more documents to be sent, either via the attachment feature, or by drag-and-drop, or using
the OpenTouch Fax Center printer (see Managing Fax Documents on page 15).

g~ Tip: Atthis step, you can reorder, cancel, or delete fax pages as you wish. You can also add
annotations in the fax preview pane (see Annotations Overview on page 41).

. Address the transmission with a fax number, an email address or recipients from your contact lists (see

Addressing Transmissions on page 16).

If needed, modify the sender information or the fax transmission settings (see Modifying Transmission
Settings on page 19)

If needed, modify the fax resolution (see Sending a Fax with a Specific Resolution on page 21)

. Click Send to send the fax and close the SendFAX application.

g~ Tip: You can choose File > Send without Closing if you wish to compose another fax.

Using Cover Sheets

Selecting a Cover Sheet

To select a cover sheet, use the drop-down cover sheet menu of the toolbar.

14
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g~ Note: OpenTouch Fax Center offers default cover sheets. In addition, the cover sheet editor allows you
to compose and save your own cover sheets. Refer to Cover Sheets Overview on page 71 for more
information.

g~ Note: A fax sentto an email address behaves differently when sent with or without a cover sheet. See
Email Behavior With or Without a Cover Sheet on page 7 for more information.

Adding a Comment to a Cover Sheet
To add a comment to a cover sheet, select a cover sheet and go to Edit > Cover Sheet Comments.

Note: When sending a fax to an email address, a default message can be used when no comment is

&
entered on the cover sheet. See Email Content on page 11 for more information.

Managing Fax Documents

Here is the list of actions available to modify the fax being sent with SendFAX:

Inserting a Document

It is possible to add pages to the fax you are composing by using existing documents. A lot of file types are
supported: it can be, for example, a Microsoft Office document, a basic text file, an image, a PDF file...

To proceed, click W' and browse for the file to insert.

All the pages of the selected document are converted into the TIFF format and inserted as new pages after
the last page of your fax.

' Note: More than one document can be added to the same fax.

Reordering Fax Pages

The pages of the fax being sent can be reordered through the Thumbnail View.

To proceed, select a page and use the & and # buttons to move it up and down.

Note: You can also quickly move the page to the first or last page of your fax by selecting Thumbnail
[Maéve and choosing First or Last. Note that “first” means “the first page after the cover sheet”, if there
is a cover sheet.

[ 1

Another way to move the pages can be dragging and dropping the page trhough the Thumbnail View (insertion
point will be indicated by two yellow arrows during the dragging phase).

Cancelling the Transmission of a Page

This function can be useful when you want to send only a part of your fax without having to physically remove
the undesired pages.

To mark the pages that will not be sent with the fax, select them in the Thumbnail View and click .

All the cancelled pages are marked with a red sign. If you need to restore the cancelled pages, just select
them and click again the (& button.

Deleting a Page

To physically remove a page from the fax, select it and click # above the Thumbnail View.
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Saving a Fax
To save a copy of the fax in your PC, select File ["Sdve As.

' Note: The faxes are saved in the TIFF format.

Printing a Fax
To print the current fax, select File [Print.

g~ Note: For setting a specific print resolution as default, see Setting the default fax resolution for printing
on page 14.

Addressing Transmissions

You can address a transmission by entering manually a recipient or by selecting a contact from one of your
phone books.

More than one recipient can be added to the recipient list of the fax being sent. Also, that list can be easily
modified.

Manually addressing a transmission

How to address manually a fax from SendFAX.

1. Type a name in the To field.
2. If desired, type an entry in the Company field.
3. Type a fax number or an email address in the Destination field. Only this entry is mandatory.
g~ Tip: Youcanadd a "+" signin front of an international country code to apply the correct formatting

to the To: fax number on the Cover Sheet. However, the "+" sign feature may not be supported
depending on your phone company and/or the fax server configuration done by your administrator.

- Tip: If you need to add a DTMF code (such as an extension number or a long-distance code), you
can enter it after the fax number, preceded with one or several pauses (comma or letter p — not case
sensitive).

For example: (514) 222-3333p1234 (equivalentto (514) 222-3333,1234).

4. If desired, type an entry in the Subject field.

9 Click %,

The recipient is added to the Recipients list.

g~ Tip: Any recipient of the Recipients list can also be added to the currently selected phone book (even
if not displayed), by right-clicking on the recipient.

Selecting a recipient from a phone book

How to address a fax by selecting a recipient from a phone book in SendFAX.

1. Choose View > Phone Book > Show Right if the phone book section is not displayed on the right of the
SendFAX interface.
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2. Use Selected phone book to select your contact list, if needed — according to your current integration
(see Phone Book Integrations on page 11).

3. Search and select contacts according to the selected source:

+ Web Phone Book: Start to type the text to search (contact/group name, company or fax number) to
see results in the list, then select the targeted contact or group.

» Local Phone Book: Start to type a contact/group name to quickly browse through the list, then select
the targeted contact or group.

4 Glick €.

The recipient is added to the Recipients list.
' Note: If the contact Preferred Address is an email, the fax will be sent to the email address and not to
a fax number. See Phone book contacts on page 27.

5" Tip: Any recipient of the Recipients list can also be added to the selected phone book, by clicking ey

Selecting a recipient when the phone book is not displayed

How to select a recipient from a phone book in SendFAX when the phone book is not displayed in the interface.

1. In SendFAX, click £ or the To button.
SendFAX displays the phone book view in a separate window.

& Select Recipients E3

Selected Phone Book: I Contacts j

Twpe name or select From list:

I Recipients: X
ﬁ | Mame | Company | Destination & ﬁ| Hame | Company | Destination
£ Jane Doe Example & Co. jane. doe@exan. .
@ Robert Pepper Example & Co. B58-7ER-4321
1] | ]
Propetties. .. | Find... | 4| | |

QK I Cancel | Help |

2. Use Selected phone book to select your contact list, if needed — according to your current integration
(see Phone Book Integrations on page 11).

3. Search and select contacts according to the selected source:

4

+ Web Phone Book: Start to type the text to search (contact/group name, company or fax number) to
see results in the list, then select the targeted contact or group.

» Local Phone Book: Start to type a contact/group name to quickly browse through the list, then select
the targeted contact or group.

4 Click %,
The recipient is added to the Recipients list.

Note: If the contact Preferred Address is an email, the fax will be sent to the email address and not
to a fax number. See Phone book contacts on page 27.

[
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g~ Tip: Any recipient of the Recipients list can also be added to the currently selected phone book, by
right-clicking on the recipient.

5. Click OK to close the phone book window.

Modifying the Recipients List

How to modify parameters within the recipients list in SendFAX.

You may need to change some information or parameters of the recipients after having added them to the
Recipients list.

g~ Note: Any modification applied this way to the recipients do not affect the information contained in the
phone book, but only for the fax being sent.

Here are the possible actions:

Editing the fax recipient information

This option allows you to change some information of the recipients, only for the fax being sent, without
changing anything in the phone book.

To proceed, select the recipient in the Recipients list and click E=.

Changing the recipient destination

This option can be useful when the contact has more than one fax number or email address and you wish to
select another one than the default one for the fax being sent.

To proceed, right-click on the recipient in the Recipients list, select Destinations and choose the fax number
or email address to use for the transmission.

Filtering the recipients list for the transmission

This option allows you to deselect/select recipients of the Recipients list in order to send them or not the
current fax. It can be useful if you need to address two slightly different versions of the same fax to two different
batches of recipients that are in the same recipient list.

To proceed, check or uncheck the box beside the name of each concerned recipient in the Recipients list.

g~ Note: Once the fax is sent to the first batch of recipients, the recipients list and the fax are still displayed,
so you can modify the fax and send it to a second batch of recipients only by checking and unchecking
boxes.

Deleting a recipient from the recipient List
This option simply removes the recipient from the Recipients list.

g~ Note: There is no possible undo.

To proceed, select the recipient in the Recipients list and click X,
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Modifying Transmission Settings

Editing sender or company information

How to modify the information appearing on a fax in SendFAX.
You must have the modifications rights at this level. If not, please contact the administrator.

You might need to modify sender and company information that will appear on the fax being sent, without
modifying this information as it is written in the OpenTouch Fax Center database. For example, it might be
necessary to edit sender information when you send a fax on behalf of another user.

Changes to sender and company information are applied only to the current fax, and the next time you will
use SendFAX, all this information will be taken back from the fax server database.

Note: You can however choose the option to remember your changes for all future transmissions trough
SendFAX. It will not affect, anyway, your real information written in the database.

To proceed:

1. Click E1.

2. In the Sender Information tab, check the Use Custom Sender & Company Information box.
Faxing Properties E|

Sender Informatian ] Company Infarmation ] Fax Settings ]

[¥ Use Custom Sender & Company Information W Remember My Infarmation

Personal Information

Salutation:

First Mame:

Last Mame:

Job Title:

Cellular:

|
|
|
E-mail: | Useri@mycompanty . com
|
|

Pager:

Billing Information

Eilling Code : |

Sl
Sl

Sub Eiling Code |

QK | Cancel | Help

You can now modify the fields.

g~ Note: If you check the Remember My Information box, the changes will be used as well for future
SendFAX sessions.

3. To modify the Information of the company, select the Company Information.
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Faxing Properties

X]

Sender Information  “ompany Information ] Fax Settings ]

Comparry Information

Campany:

Address:

Skate:

|
|
Citys |
|
|

Counkry:

Zip: [

Phone Information

Phone: |

Fax: |

QK | Cancel Help

4. Click OK to apply the information to the transmission.

Changing fax transmission settings

How to change the transmission settings for a fax in SendFAX.
You must have the modifications rights at this level. If not, please contact the administrator.
Transmission settings include the fax priority and the number of retries, and notification options.

1. Select Edit > Faxing Properties.
2. Select the Fax Settings tab.
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Faxing Properties x|

Sender Irrforrnatiu:unl Company Information  Fax Settings |

™ Use Custom Fax Settings

— Fax Settings

Priority: m
Retries: I“—
[V | Matify Success

[W | Matify Failed

™| Broadeast notification

™ Delay Transmission Until: | 7/ /2010 jl 6:00:00 PM j‘

QK I Cancel | Help |

3. Check the Use Custom Fax Settings box.

g~ Note: This will apply the custom fax settings to all future fax transmissions. To change the settings
only for one transmission, you need to return to this dialog and uncheck the Use Custom Fax Settings
box.

4. Use the Priority dropdown box to select High, Normal, or Low.

5. Type a Number of Retries.
The highest available number is 99.

6. To enable or disable the notifications for the fax, check or uncheck the Notify Success or Notify Failed
boxes.

7. If you want to enable or disable the reception of a single notification (summary) after a broadcast fax
emission, check or uncheck the Broadcast Notification box.

g~ Note: Enabling this type of notification does not suspend the other outgoing fax notifications. If you
leave the Notify Success and Notify Failed boxes checked, the profile is still set to receive notifications
for all the fax communications inside a broadcast.

8. If you wish to delay the sending of the current fax, check the Delay Transmission Until: box and enter
a date and time for the delay.

g~ Note: The transmission delay will apply only to fax transmission towards fax numbers. Fax
transmissions towards email addresses will be sent immediately.

9. Click OK to apply the settings to the transmission.

Sending a Fax with a Specific Resolution

Prior to sending a fax, you can change its resolution using the procedure in Setting the default fax resolution
for printing on page 14.
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Submitting a Fax With SendFAX Through a Command Line

How to send a fax in silent mode.

g~ Note: This section concerns advanced users.

It is possible to accelerate the sending of a fax with SendFAX by using a command line instead of opening
the application.

From the install path\client folder, enter the following command line:

SendFax.exe

g~ Note: This command opens SendFAX application.

The available arguments for the command line are:

» /c: To enter the recipient information;
» /a: To attach afile to the fax;
+ /s: To define the subject of the fax;

* /q: To send the fax and quit automatically the application. When it is absent, SendFAX opens with all the
destinations and you must click on the Send button to send the faxes.

g~ Note: Dashes used in front of the arguments can be replaced by slashes.

g~ Important: The fax=oremail= information must be present in the recipient information (/c) otherwise
the fax will not be sent. The fax number or email address must be valid. To send to an email address,
the fax=information must not be present in the recipient information, if information for both the fax=and
email= appear, the fax number will take precedence. A recipient information line must be created for
each fax number and each email address.

For example:

SendFax.exe /s "This is the subject" /a "attach file.tif" /c
"fax=5141234567/fn=Jane/1ln=Smith/co=MyOrganization /email=jane.smithQRexample.com" /c
"fax=5147654321/fn=John/1n=Smith/co=MyCompany" /c
"email=robert.pepper@example.com/fn=Robert/ln=Pepper/co=Example & Co." /g

In this example, the fax would have:

* “This is the subject” for Subject
« “attach_file.tif” as attached file
» Three recipients:

» Jane Smith, 514.123.4567, MyOrganization, jane.smith@example.com
* John Smith, 514.765.4321, MyCompany
* Robert Pepper, robert.pepper@example.com, Example & Co.

+ Sentsilently (/q)
The first two are sent to fax numbers and the third is sent to an email address.

Here is a list of the available fields for a fax sent by command line:

Fields Description

dear=, first=or fn=, last=or ln= Basic information concerning the recipient
address=, city=, state=, zipcode=, country= Recipient Addressing information
phone=, pager=, cellular=, email=, fax= Recipient Contacting information

22 8AL90087ENAA - Ed. 01 - August 2020 - OpenTouch Fax Center User Guide



Chapter 2 | Faxing with SendFax

Fields Description
company= Of co=, jobtitle= Company and title of the recipient
billingcode= or bc=, subbillingcode= or sbc= Billing Code and Subbilling Code of the recipient
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Chapter 3 SendFAX Local Phone Book

Local Phone Book Overview

The SendFAX Local Phone Book is an application that is installed locally (on your computer) and stores
contacts intended to be used as fax recipients through SendFAX.

At its first installation, the Local Phone Book application contains a single empty phone book — which resides
inthe <install path>\Client folder and has the .xmc extension.

You can add an unlimited number of contacts in this phone book (with contact’'s name, fax number, address,
company and business address, etc.), and even create multiple phone books through the same application.
There are three ways to add contacts in the Local Phone Book:

» Manually, using the phone book application interface,
» By importing a contact list from an external data source, or
» By linking the phone book to an external data source.

In the first two cases, the data will actually reside within the phone book. You can modify it whenever necessary.

In the third case, the data resides in the external source; it is only displayed through the phone book. If
information is to be changed or updated, you must update the external source using the software that created
it.

Launching the phone book

To launch the phone book:

* Among your installed OpenTouch Fax Center applications, choose Phone Book; or
* In SendFAX, choose Tools [FaxCenter Phone Book.

The default phone book and contact list or those you last opened are automatically displayed. An example
is depicted in the following screenview.
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File Edit Wiew Tools Help

D& pme@ X=E & ?

Type Mame or Select From List Show Mames from the
|| I Contact ﬂ
% | Last Mame * | First Mame | Compary | Fax Mumber |
ﬁ Howaard Ay A14-265-3693
ﬁ Pepper Raobert Baob Inc. 514-123-4567
ﬁ Smith John Jo Corp. A14-587-6043
Ready 3 Contacks MUM |

Figure 3: View of the phone book

By default, a phone book displays contact information in four columns: Last Name, First Name, Company,
and Fax Number. However, you can adjust the column headings to display any of the information fields
available in the phone book.

You can select any column heading as the sort key. For example, the default sort key is Last Name in
ascending order. If you wish, you can select Fax Number, Company, or any other displayed column heading
as the sort key. Sort order can be ascending or descending.

To insert or delete a column, right-click on the heading bar and select Insert Column or Remove This

Column.

g~ Note: When inserting a new column, it is automatically added on the left of the clicked column heading.

Menu Bar Details and Associated Icons

Description of all the items of the Phone Book menu bar.

The File Menu
O New allows you to create a new phone book, a new contact list within an existing phone book,
a new contact in a contact list, and a new group of contacts.
= Open allows you to open an existing phone book, a contact list, or a public phone book, if existing.
Save As saves a newly created phone book.
Import imports data from an external data source.
Link links a phone book to an external data source.
Link Fields allows you to update the links that match the fields of an external data source to the phone
book’s internal fields.
Exit closes the phone book.
The Edit Menu
Properties displays the properties of a selected contact or group.

26
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w Delete deletes a selected contact, group or contact list.
Select All selects all contacts in the currently displayed contact list.
The View Menu
Display Name switches the order in which names are displayed.
Toolbar displays or hides the toolbar at the top of the phone book window.
Status Bar displays or hides the status bar at the bottom of the phone book window.
Languages enables the choice of language.

The Tools Menu

3] Find Contacts performs a search for a contact.
Advanced Find performs a search for a contact and allows more detailed search
criteria.
Contact List Management lets you rename, edit, and delete the contact lists already present in
the phone book.
Compact Database compacts the phone book database.

Phone book contacts

A phone book is composed of at least one contact list. A contact list is a list of potential fax recipients detailing
their first name, last name, company name, and address, fax number, e-mail address, etc. A phone book can
have any number of contact lists, however, only one contact list can be used at a time. A default contact list
named Contact is generated when you create a new phone book.

In the phone book, contact lists are chosen using the Show Names from the drop-down list (see the figure
in Launching the phone book on page 25).

Ample information fields are available for every contact. These fields are accessible by selecting Edit 1
Properties after having selected a contact or alternatively by right-clicking on the desired contact from amongst
those in the contact list. A sample screenview is depicted below:
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Contact Properties

Genstal | User Defined |

—Conkack Marne

Full Mame. .. | |Ju:|hn Stk

Job Title I Sales managar
—Company —Contack Mumnbers

Mame : | Jabn Srrith Phane Mumber: | 1-555-123-4567

Street : 1111 Awenue Av, Extension : I

Pager : I

Ciky 5 | 1y City Fax : v | 1-555-123-4567

StatefProvince : IMy Province Cellular : I 1-555-123-4567

ZIFjPostal Code : IP-IP. 141 E-mnail : - Ijsmith@mycnmpany.com|

Country § I My Counkry j Prefered Address : IFax MNumber j
r— Biiling Infarmation

Billing Code : I Sub Billing Code ; I

[al'4 I Zancel Help |

. Note: Up to three Fax numbers and up to three Email addresses are available by clicking on the ~

opposite either of these respective information fields. The Preferred Address field allows you to select
the one that SendFAX will use when several are specified.

If the Preferred Address is an email, the fax will be sent to the email address and not to a fax number.

. Tip: You can add a "+" sign in front of an international country code to apply the correct formatting to

the To: fax number on the Cover Sheet. However, the "+" sign feature may not be supported depending
on your phone company and/or the fax server configuration done by your administrator.

Clicking Full Name allows you to enter a title (Dr., Mr., Miss, Mrs., or Prof.) and first and last names, as
depicted in the following screenview. The title will appear as a salutation in the fax.

Name Details

Title Mr,

X

-

Firsk : I John

| Smith

o]

Last :

Cancel | Help |

Additional information can be entered clicking the User Defined tab. For example, having entered the company
address in the address fields, you might wish to use the User Defined fields to enter a contact's personal
address. Four user-defined fields and a comment field are provided, as depicted in the following screenview:
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Contact Properties il

General  Jser Defined |

ser Defined 1 :

Iser Defined 2 &

User Defined 3

Iser Defined 4 &

|
|
|
|
Comment : | ;I

[al'4 I Zancel Help

Managing Phone Books

Opening a Phone Book

To open a phone book click & and select a . xnc file.

Adding a Phone Book

To add a phone book click [} then name the new phone book and click save.

You can now populate the default contact list with contacts and, optionally, with groups.

Managing Contacts Lists

Adding a Contact List

To add a contact list, click then name the new contact list.

Renaming and Deleting a Contact List

It is possible to rename or delete a contact list via the contact list management menu. To proceed, go to
Tools > Contact List Management then select a contact list.
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Managing Contacts

Adding a Contact

To add a contact, click £ then fill in the contact information.

g~ Note: No field in the contact information is mandatory. The phone book prompts for a first name when
none is entered. However, you are not obliged to enter one. You can even create an empty contact for
later completion.

Deleting a Contact

To delete a contact, select a contact and click =,

g~ Note: Contacts are listed as individuals and as group members. Deleting an individual contact deletes
that contact from any group it is members of.

Editing a Contact

To change a contact's properties, select a contact then click 2.

Phone Book Groups

A group is composed of a number of individual contacts and, optionally, other groups. By selecting a group
when faxing, you fax to all contacts in it. A contact list can include any number of groups.

The contacts you place in a group remain listed as independent contacts in the contact list. If you delete the
group, the members remain available as independent contacts. If you delete them as individual contacts,
however, they are also deleted from the group.

The sections immediately following provide details on how to manage your groups.

Adding a Group

To add a group click ® and name the new group.

g~ Note: Itis possible to add new or existing contacts to the group while creating it.

Managing a Contact or Group in a Group

To add a contact or group to a group or to remove a contact or group from a group, select a group then click
=]

Deleting a Group

To remove a group click x.

g~ Note: Contacts are listed as individuals and as group members. Deleting a group does not delete a
contact’s individual listing.
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Compacting the Database

In order to retrieve the space of unused fields of the contacts information, it is possible to compact the database.
To process, go to Tools > Compact Database.

Phone book searches

The phone book offers a basic find and an advanced find. The basic find searches a single contact list and
specifies the exact entries you expect to find in information fields like First Name, Last Name, and Fax
Number.

An advanced find allows you to specify a wider range of criteria. You can select any of the information fields
available and specify several search criteria. Further, an advanced find can specify more than one contact
list.

Both types of searches can be saved and re-used later.

The sections immediately following provide details on how to perform searches.

Finding a contact

1. In the phone book, choose Tools > Find Contacts.
The phone book offers Name, Company, Fax Number and City as search criteria.

Find Contacts x|

Marne:

Campany':

Ciby:

|

|

Fax Mumber: I
- |

|

[ save as

FEimd M I Cancel | Advanced | Help

2. Type the appropriate entries.
i~ Note: UselZto change City to State/Province or Country.

3. Select Save As and enter a name if the search is to be saved.

Note: Saved searches can be retrieved and executed using the Show Names from the selection
box, at the top right of the phone book window. They are listed under the View heading.

4. Click Find Now.

5. If necessary, click Advanced to switch to an advanced search. For details on performing advanced
searches, refer to the following section, Using advanced find on page 32.
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Using advanced find

1.

In the phone book, choose Tools > Advanced Find.

Advanced Find x|
Loak. In: I Conkacks Browse. .. |

Find items that match these criteria:

Field | Condition | value |
Remove |
—Mew Criteria
Field: Condition: Yalue:

[A—— | =] |
fidd (o) Lisk |

—Opkions
% Match any criteria
™ Match all criteria
[ Save as I

FEimd M I Close | Mew Search | Help |

g~ Note: By default, the current contact list is selected. Use Browse to select or deselect contact lists.

Under New Criteria, use Field to select an information category.

Use Condition to select a condition. Conditions include contains, is exactly, begins with, doesn't
contain, is empty, and is not empty.

Under Value, type an entry that represents the expected results. The is empty and is not empty conditions
require no Value entry.

. Click Add to List.

g~ Note: You can specify one or more criteria. Use Remove to make any corrections.

Under Options, select Match any criteria when two or more criteria exist and any one fulfills the conditions
of the search.

g~ Note: To apply every criteria to the search, select Match all criteria.

. Select Save As and enter a name if the search is to be saved.

g~ Note: Saved searches can be selected and run using Show Names from the. They are listed under
the heading View.

8. Click Find Now.
9. If necessary, click New Search to create another search.
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External data sources

External data sources can be imported into a phone book, either as a new contact list or into an existing
contact list. Once resident in the phone book, the contacts can be updated like any other contact. Possible
external data sources are:

» OpenTouch Fax Center Phone Book

* A comma separated value (.csv) text file.

* Microsoft Excel

* Microsoft Access

* An ODBC-compliant (Open DataBase Connectivity) data source
e Borland dBASE IlI, IV, and 5

+  Symantec ACT!

External sources might be a worksheet in a spreadsheet or a table in a database that contains a list of names
and fax numbers. By importing the source, you import the names and fax numbers into the current contact
list.

The external source should be properly organized, with field names that correspond in meaning, if not in exact
phrasing, to the information fields used by the phone book. For example, a field called Name in an external
data source might include both first and last name. First Name and Last Name, however, are two distinct
fields in the phone book. You may wish to update the external source before importing it.

You may need to assign fields being imported to the corresponding fields offered by the phone book. When
field names match phone book names closely or exactly, OpenTouch Fax Center automatically links the field
in the external source to the corresponding phone book field. When field names do not correspond, you are
given an opportunity to link them manually.

Importing an external data source

Although other external sources are available, this example imports information from a Microsoft Excel
spreadsheet.

1. In the phone book, choose File > Open to select the correct phone book.

g~ Note: If necessary, use Show Names from the to select the correct contact list.

2. Choose File > Import.
3. Use Select the format of your database to select Excel.

g~ Note: Click First Row Contains Field Name if the first row of the spreadsheet represents the field
names or column headings.

4. Type the path and name of the file in the field provided. Alternatively, click Browse to navigate the file,
select it, and click OK.

5. Click Next.

6. Select the worksheet that contains the contact information.

7. Click OK.
The phone book attempts to match corresponding fields. However, should field names in the external
source not match, you must perform the link yourself by clicking in the right hand column where the phrase

No Link appears. A pull-down list displays the phone book fields available. Use AutoMatch to instruct
the phone book to apply the most likely match. Use Reset to clear all matches and begin again.
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8. Click Finish.

Linking to an external data source

External data sources can be linked to a phone book. A linked external source is always treated as a new
and distinct contact list. OpenTouch Fax Center uses the name of the table or worksheet as the name of the
contact list. The name, which must be unique, can be changed either during the linking operation or afterwards
through Edit > Rename. It is subsequently displayed in the Contact List field.

You cannot link an external contact list into an existing contact list.

The contacts in a linked contact list cannot be edited or updated through OpenTouch Fax Center . The phone
book displays this information in read-only format. If contact information in a linked contact list is to be changed,
you must update the source itself. Contacts in a linked contact list cannot be assigned to a group. Additional
contacts cannot be added, individual contacts cannot be deleted directly through the OpenTouch Fax Center
Phone Book.

Because linking is dynamic, the changes you make to the contents of source are reflected in the linked contact
list.

You can update the fields in a linked contact list. For example, if you add a new field to the source, or change
the field name of an existing field in the source, it may be necessary to link it to a specific phone book field.

An example is provided in the section immediately following.

Linking procedure

Although other formats are available, this example links information from a Microsoft Excel spreadsheet.

1. In the phone book, choose File > Link.

2. Use Select the format of your database to select Excel.

3. Click First Row Contains Field Name if the first row of the spreadsheet represents the field names or
column headings.

4. Type the path and name of the file in the field provided. Alternatively, click Browse to navigate the file,
select it, and click OK.

5. Click Next.

6. Select the worksheet that contains the contact information.

7. Click OK.
The phone book attempts to match corresponding fields. However, should field names in the external
source not match, you must perform the link yourself by clicking in the right hand column where the phrase
No Link appears. A pull-down list displays the phone book fields available. Use AutoMatch to instruct
the phone book to apply the most likely match. Use Reset to clear all matches and begin again.

8. Click Finish.

Updating a linked external source

1. In the phone book, use the drop-down menu to select the linked contact list.

2. Choose File > Linked Fields.
The Set Link window appears.

3. Use the pull-down list by right-clicking the right hand column for the appropriate field.
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4. Select the phone book field that best corresponds to the external field name.
5. Click Finish.

g~ Note: Reset sets all phone book fields to No Link. Reset might be used when a linked external
source is greatly modified and a good many links must be manually assigned.
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Chapter 4 Viewing Faxes

Overview

You can view a fax in a variety of softwares, whether the fax image file format is TIFF or PDF.

If your preference is a TIFF format, you can use the OpenTouch Fax Center Viewer as your default application
to view the faxes. When the Viewer is installed on your computer, it opens automatically when you select the
viewing feature on a fax from your fax list.

Through the Viewer, you can:

* have a global view of the fax pages through a thumbnail view of all pages
 rotate the fax pages and use a zoom tool for a better display

But also:

» annotate the fax
» print the fax
» save a local copy of the fax

Launching the Viewer

Among your installed OpenTouch Fax Center applications, choose TIFF Viewer.

g~ Note: When you choose to view a fax from your list of faxes, the fax opens automatically in the Viewer.

The viewer will be displayed, as depicted in the following screenview (with an example of fax):
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At the top, several display and annotations tools are available (listed in section: Menu Bar Details and
Associated Icons on page 38). On the left is the thumbnails view, where you can see all the pages of the fax,
and on the right is the main view, where you can see the page selected in the thumbnails view.

Menu Bar Details and Associated Icons

The File Menu
= Open Opens an existing TIFF file. The TIFF file format is used for faxes.
Eh Print Fax Sends the fax to a printer.
Save As Saves a copy of the fax (or only a part) under a new name.
The View Menu

The View menu tab displays the Main Toolbar and Annotation Toolbar options which toggle their respective
tool icons.

The Page Menu

4= First Displays the first page of the fax in the viewer’s main view.

- Previous Displays in the main view the page immediately before the one currently
in the main view.

= Next Displays in the main view the page immediately after the one currently
displayed in the main view.

= Last Displays the last page of the fax in the main view.
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H Rotate Left Rotates the page currently in the main view 90 degrees to the left.

n| Flip Rotates the page currently displayed in the main view 180 degrees.

¥ Rotate Right Rotates the page currently displayed in the main view 90 degrees to the
right.

b Rotate All Left Rotates all pages 90 degrees to the left.

n Flip All Rotates all pages 180 degrees.

r Rotate All Right Rotates all pages 90 degrees to the right.

Properties Displays the page properties, compression method, as well as resolution

and size of image.

The Zoom Menu

& Zoom in Selects the next display scale.
=] Zoom out Selects the previous display scale.
1 Fit to height Resizes the height of the page to the view.
+ Fit to width Resizes the width of the page to the view.
&3 Best fit Selects the best scale to fit the page to the view.
25% to 200% These are pre-set scales.
100% The default scale (actual size).
Custom Displays a window through which you can enter a zoom percentage.

The Annotation Menu

Annotations are notes and objects added to a document within other applications such as SendFAX and the
Viewer.

For more information about annotations refer to the concerned chapter (Overview on page 41).

The Thumbnails Menu

The Thumbnails menu offers three image sizes to display the main image in a thumbnail view on the left
side of the Viewer.

Working with the Viewer

Opening a Fax in the Viewer
To view a fax in the Viewer from a file, select File [—Open and browse for the file.

g~ Note: The file must be a TIFF file generated by the Fax Server. It can contain more than one page.

Opening a Fax from the Fax List

It is possible to view a fax directly from your fax list (received or sent) by selecting the viewing feature for the
concerned fax. The Viewer opens then automatically.
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g~ Note: Faxes opened from your fax list are stored in the server mediastore and cannot be modified.
However, you can save a local copy of the fax if you wish to keep the modifications applied with the
Viewer (see Saving a Local Copy of a Fax on page 40).

Managing the Viewer Display Settings

The Viewer allows you to change the fax pages display in a variety of ways, by using the displaying and
zooming tools (see The Page Menu on page 38 and The Zoom Menu on page 39).

Also, the thumbnail view (on the left) allows you to have a global view of the fax when it contains more than
one page, and easily browse in these pages (see The Thumbnails Menu on page 39).

g~ Note: By default, the pages are displayed in a vertical way, but you can extend the size of the thumbnail
view to the right in order to view them side by side in rows, if the fax contains a lot of pages.

Adding Annotations

To add annotations to your fax, please refer to the concerned chapter: Overview on page 41.

Saving a Local Copy of a Fax

If you have made modifications to a fax, for example, by adding annotations, you may wish to save a local
copy on your computer's hard drive, leaving the original unmodified. To save a local copy, select File [Save
As, browse for the location and enter the name of the new file. The . tif extension is automatically applied.

g~ Note: If the fax was already open from a local file, you can also select File [-Save if you wish to update
the file without making a copy.

If you wish to save partially the fax (only some pages), select the Pages range option and indicate the

concerned pages in the field. For example:

* 1-5, if you wish to save the pages from 1 to 5.
* 1,5, if you wish to save the pages 1 and 5.
» 1,3-5if you wish to copy the pages 1, 3, 4 and 5.

' Note: You can do a combination;

Printing a Fax from the Viewer

To print a fax with the viewer, select File [Prdnt Fax.
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Using Annotations

Overview

Annotations are notes and objects added to a fax within SendFAX or the Viewer. There are five types of
annotations: text, line, rectangle, stamp and highlighter.

Annotations are added by selecting the type of annotation, drawing and adding text if needed. All annotations
can be resized and moved around the page. Annotations can also be formatted. Color and thickness can be
assigned to lines and rectangles; color, font, and size can be assigned to text.

Annotations that have been added are not permanent. They are superimposed on the page in the Fax Preview
page and incorporated in the TIFF file generated when you transmit the document. The source or original
document remains unchanged.

[ N

Note: The Annotations feature cannot be used on cover sheets when composing a fax in SendFAX.

Annotation Types

There are five types of annotations available through the Annotation Menu or Toolbar's icons :

dlz

e

Text

Line
Rectangle

Stamp

Highlighter

draws a text box on the currently displayed page. Type the text immediately after drawing
the box. Text boxes can be resized by clicking them and dragging the handles.

draws a line on the page.
draws a rectangle on the page.

displays a window through which you select a bitmap (. bmp) file. Select the bitmap file you
wish and drag the cursor to form a rectangle. The selected bitmap graphic is written to the
page.

e Note: Like any annotation, bitmap stamps can be selected and resized.

draws a rectangular, yellow colored rubber band. Use it to highlight important text.

Working with Annotations

Here are the possible actions you can do with annotations:
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Adding an Annotation

To add an annotation, select one of the annotation types in the annotation toolbar, then draw by clicking and
dragging the cursor on the page.

' Note:

* Inthe case of a bitmap annotation, you need first to select an image (only files with the . bmp extension)
through an Open window.
* Inthe case of a text annotation, you can directly write the text in the box after its creation.

All the annotations are modifyable objects that are placed over the page where you draw them. Therefore,
you can move, resize or reformat them afterwards (see the following sections).

Selecting an Annotation

To be able to select an annotation that has been already added, you must enable the E button to activate
the pointer. You can then click on the annotation to select it.

g~ Note: ltis also possible to select or deselect all the annotations of a page by selecting Annotations [_1

Select All or Annotations [Unselect All.

Moving an Annotation

To move an annotation, just drag-and-drop it to the new location on the page.

Resizing an Annotation

To resize an annotation, select it, then use the appearing handles (black squares around the annotation) to
give it the new size.

Formatting an Annotation

It is possible to modify the visual properties of the line, rectangle and text annotations.

To proceed, select the annotation and click in the annotations toolbar:

» For the line and rectangle annotations, you can change the color and the thickness of the lines.
» For the text annotation, you can change all the properties of the font and the color of the background.

Editing a Text Annotation
To edit the text of a text annotation, just select it and enter the new text.

g~ Note: Itis possible to edit the text by accessing the properties of the text annotation (see the previous
section).

Deleting an Annotation
To delete an annotation, select it and click # in the annotations toolbar.

Hiding or Showing the Annotations

If you need to hide or show the annotations you made, select Annotation ["SHow Annotation.
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Chapter 6 Fax Utilities for General Applications

Overview

OpenTouch Fax Center provides several utilities that allow you to send faxes directly from your general
applications. These utilities are of two types:

» Printer drivers, used as normal printers, that convert your current document to a TIFF file that is attached
to a fax to be sent via:

» SendFax (see Faxing from Windows Applications by Using SendFAX on page 43)

» Email (see Faxing From Windows Applications by Using PrintToMail on page 44)

+  Web Fax Composer (see Faxing from Windows Applications by Using the Web Fax Composer Printer
on page 45)

» Integrated faxing features:

» Fax Macros usable in MS Word (see Sending a Fax Using the Fax Add-in for MS Word on page 45).

g~ Note: The Fax Macros use SendFAX to finalize the sending.

» The Microsoft Office Internet Fax Service feature (see Sending a Fax Using the Microsoft Office Internet
Fax Service on page 48).

Faxing from Windows Applications by Using SendFAX

If SendFAX is installed on your computer, you can fax from any Windows application installed on your system
that has print capabilities. You can perform these fax operations using any Windows application.

1. Open with the appropriate application the document to be faxed.

g~ Note: For example, it can be a MS Word document you just wrote and saved.

2. Access the print options of the application (e.g. Print... for MS Word).
3. Select the FaxCenter printer in the list of available printers.

g~ Note: If you need to set a specific resolution for your fax, click Properties [ Pdper/Quality [_1
Advanced. The Graphic-Print Quality field allows you to choose Low(200x100), High(200x200),
Fine(300x300) or Ultra Fine(400x400) quality. After validation, the new resolution setting remains
until you change it again. If the printer driver default resolution is higher than the maximum resolution
allowed by the user profile, SendFAX rejects the rasterized file, pops up a warning for the user and
stays open.
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Click OK.
SendFAX s launched — either its full or basic interface, depending on your SendFAX settings (see SendFAX
Interface Display Options on page 13).

g~ Note: You can print additional documents to the fax being sent, by repeating the previous steps (from
the same or any other application).

. Address the fax.

g~ Note: The minimum required is a fax number; SendFAX full interface allows you to benefit from other
addressing features (e.g. subject, multiple recipients, phone book...). For more information see Overview
on page 3.

g~ Tip: Youcan add a "+" signin front of an international country code to apply the correct formatting
to the To: fax number on the Cover Sheet. However, the "+" sign feature may not be supported
depending on your phone company and/or the fax server configuration done by your administrator.

. Click Send.

Faxing From Windows Applications by Using PrintToMail

The PrintToMail printer driver allows you to send faxes from any Windows application, as if you were printing
the document from this application. This driver converts the document into the TIFF format and put it in an
e-mail as attachment.

[ 1

Note: To be able to use PrintToMail, the fax server must be interconnected with an e-mail system.

To fax from a Windows application:

1.

(d

Open with the appropriate application the document to be faxed.

g~ Note: For example, it can be a MS Word document you just wrote and saved.

Access the print options of the application (e.g. Print... for MS Word).
Select the PrintToMail printer in the list of available printers.

If you need to set a specific resolution for your fax, click Properties ["Pdper/Quality ["Advanced.
The Graphic-Print Quality field allows you to choose Low(200x100) or High(200x200) quality for the
TIFF file to be created.

g~ Note: After validation, the new resolution setting remains until you change it again.

g~ Note: When using PrintToMail, if the printer driver default resolution is higher than the maximum
resolution allowed by the user profile, you will receive a failure notification.

Print the document.
Your default e-mail software opens and a new e-mail is created where your document has been added
as attachment (TIFF file).

. Address your email according to your e-mail software as for sending a fax. You can either select a contact

in your list of contacts (this contact must have a fax number), or type a fax number with the appropriate
syntax in the address field.

44
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g~ Note: For example:

* In MS Outlook,
type:
[FAX:1234567890]

g~ Tip: You can add a "+" sign in front of an international country code to apply the correct formatting
to the To: fax number on the Cover Sheet. However, the "+" sign feature may not be supported
depending on your phone company and/or the fax server configuration done by your administrator.

7. Complete fax composition and setting selection.
8. Send the message.

Faxing from Windows Applications by Using the Web Fax
Composer Printer

The Web Fax Composer printer driver allows you to send faxes via the Web Client interface by printing
documents from any Windows application. This printer driver converts the document into a TIFF file and
uploads it as an attachment in the web fax composition interface. See Attaching Documents to a Fax by Using
the Web Fax Composer Printer on page 115

Sending a Fax Using the Fax Add-in for MS Word

Two features have been implemented to send faxes with OpenTouch Fax Center from MS Word:

» The Send Fax feature, allowing to simply send your current document as a fax.
+ The Fax Merge feature, allowing to broadcast a fax with a dynamic content by using the MS Word Mail
Merge feature.

g~ Note: Both features use the SendFAX application to finalize the sending of the faxes. Therefore, SendFAX
must be installed on your computer. If the Fax Add-in for Microsoft Word and/or SendFAX are not installed
on your computer, please contact your administrator.

Sending a Fax from MS Word with the Send Fax feature

Before starting, exit SendFAX if it is running.

The Send Fax feature allows you to fax any document directly from the MS Word application (via the
FaxCenter virtual printer). To do so:

1. Open Microsoft Word.

2. Compose the document that will be used as fax message, and save it.
3. )

Click on the Send Fax button (under the Fax tab).

SendFAX is launched — either its full or basic interface, depending on your SendFAX settings (see SendFAX
Interface Display Options on page 13).

4. Address the fax.
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g~ Note: The minimum required is a fax number; SendFAX full interface allows you to benefit from other
addressing features (e.g. subject, multiple recipients, phone book...). For more information seeOverview
on page 3.

5. Click Send.

Fax Merge Feature for MS Word

The Fax Merge feature for Microsoft Word allows you to broadcast a fax whose parts of the message content
depend on the recipient (salutation or other personal information). To do so, dynamic fields are inserted in a
main document by using the MS Word Mail Merge feature. These fields are linked to an external data source
such as an Excel or Access file, your Outlook contacts book, etc.

The overall process can be summarized as follows:

1. Create or identify a data source. The entries made to the data source are the information to appear in the
MS Word merge fields.

g~ Note: The data source must contain a column with all the fax numbers of the recipients. This is the
minimum information required for broadcasting a fax.

2. Create a main document, which is the actual fax message, entering the MS Word merge fields that receive
the information entered in the data source.

3. Open the main document, map the OpenTouch Fax Center merge fields to the external data source fields,
and send the fax with SendFAX (see Sending a Fax from MS Word Using the Fax Merge feature on page
46).

Sending a Fax from MS Word Using the Fax Merge feature

Before starting this procedure, you should have access to an existing data source containing a recipient list
(for example, an Excel or Access file, or even your Outlook contact book).

g~ Important: This data source must contain a column with all the fax numbers of the recipients, which is
the minimum information required for sending faxes.

The first steps of the following procedure give the main actions to perform in order to have a document ready
for using the Fax Merge function. For specific information about the use of the Microsoft Mail Merge feature,
please refer to the MS Word online help.

To send a fax with the Fax Merge feature in MS Word:

1. Exit SendFAX if it is running.

2. Open MS Word and start a Mailing/Mail Merge process with the following attributes:
+ The document type must be Letters.

» The starting document must be the current document.

3. Select a database source containing your recipient list.
4. Prepare the content of your fax message, including all the merge fields you need to insert, and save your
document.

g~ Important: It is recommended to preview the results with the real recipient values, in order to adjust
the main document layout and prevent unwanted page breaks: if the number of pages is not the same
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for all recipients, SendFAX will fail to process the faxes. This could happen because the content length
of some fields are sometimes significantly variable from one recipient to another.

5. Stop here the usual mail merge process (do not complete the merge) and continue by following the
instructions given in this procedure.

A Attention: If you proceed with the one of the default Mail Merge final options, you will not be able to
~ send your merged documents as separate faxes.

Click on the LJ-:LJ Fax Merge button (under the Fax tab).
The Field Mapping window opens.

Field Mapping §|

Faor each of these FAX field, select the corresponding Field From
wour daka source,

First Marne: | riot selected) j
Last Marne: (not selected) =

| J Cancel
Carmparty’: | (not selected) j
Fax Murber: | {naot selected) j

7. Map the OpenTouch Fax Center fields to the corresponding ones of your data source.

g~ Note: This step is necessary for the fax to be sent correctly. For example, if the OpenTouch Fax
Center Fax Number field is mapped to a field that does not contain a fax number, the emission will
fail.

8. Click OK.
Your documents are converted by virtual printing, and then SendFAX is launched, showing the fax
corresponding to the first record of your data source; all other records also appear in the list of fax recipients.

9. At this step, you can make further modifications to the fax, such as (if needed):

» Entering a Subject.

» Selecting a cover sheet.

» Attaching additional documents (which will be common to all faxes of the broadcast).
* Removing recipients from the list.

g~ Restriction: You cannot add new recipients to the list.

10. Click Send.

All the faxes of the merge are sent separately for each recipient of the list.

g~ Note: The mapping used to send this document is not saved. Therefore, the next time you fax a main
document, you must map again the OpenTouch Fax Center fields to the fields of the data source used.
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Sending a Fax Using the Microsoft Office Internet Fax Service

MS Office programs include a built-in Internet Fax Service functionality allowing you to connect directly to a
fax service provider that will send the fax for you. As a OpenTouch Fax Center user, you can send faxes
through OpenTouch Fax Center by selecting this feature.

g~ Note: To enable this feature, your administrator must have performed some specific configuration.

The following procedure shows how to use this feature from Microsoft Word, though you can do it from other
Office applications such as Excel or PowerPoint.

g~ Note: Microsoft Outlook must be installed on your computer in all cases.

1. Open Microsoft Word.
2. Write or open the document that will be sent as fax.
3. Select the Internet Fax feature:

Depending on your version of Microsoft Office:

« Office 2007: Office Button [Sdnd [Inlernet Fax
+ Office 2010: File [Sdve & Send [Sdnd Using E-mail [Sdnd as Internet Fax
» Office 2013+: File [SHare [CErhail [Sdnd as Internet Fax

The Office Internet Fax Service interface opens. Example:

E¥ Sent with Microsoft Office 2003 Fax Service - Message

! Fle Edit ‘iew Insert Format  Tools  Table  ‘Window  Help Tvpe a question Far help = X
™ W= TN | - S *'lBIH|§§§|EEE!?;§|-%!
Pidsend | ] - | B, ¥ OB | ¥ || ) options... + | HTML -
CounkryRegion Citw/Area  Local

Fa Recipient: | Fax Mumnber: j - - Add More
Subject: Sent with Microsoft OFfice 2003 Fax Service
Attach. .. =) Task list 2009-12-15.4F (137 KE)

-~ EFa:-: Service ¥ X

Select a cover sheet

[JUse cover sheet
Template:

Preview the fax

See the fax image of
your document.,

Preview

“ooow|e

g~ Note: The original document is now a TIFF image attachment.

4. Address your fax according to the Fax Service feature available fields and options.
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Typically, you can enter:

* The name of the Fax Recipient
* The Fax Number
* A message in the main body field (that will appear on the cover sheet of the fax)

g~ Note: The Use cover sheet option available here should remain unchecked (as it is by default):
OpenTouch Fax Center is configured to add your profile's default cover sheet to the fax. If you check
this box, your fax will then have a second and needless cover sheet.

For additional information on the other Office Fax Service feature options, see the Microsoft Office
online help.

5. Click Send.

The message is sent to be processed as a fax by OpenTouch Fax Center using your account and profile
information.

g~ Note: The message is also put in your Sent Items in Outlook.
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Chapter 7 Faxing with Email Clients

Faxing with Email Clients: Overview

g~ Note: Depending on your license, some or all of the Email features described here may be unavailable.
Please refer to your administrator.

OpenTouch Fax Center allows you to send faxes and receive notifications through your email client, depending
on the configuration done by the administrator on the Fax Server.

Depending on the configuration of your email server and on your license, it is also possible to benefit from
special features available:

» on Microsoft Outlook (with Exchange and OpenTouch Fax Center forms for Outlook)

Faxing with Email Clients Using SMTP

g~ Note: Email software that use the SMTP (Simple Mail Transfer Protocol) include products like Microsoft
Outlook, Outlook Express, Mozilla ThunderBird, IBM Notes...

Fax Composition

With OpenTouch Fax Center, you can send faxes through any email software of this type. This only requires
that your administrator installed the OpenTouch Fax Center gateway for SMTP.

Note: This section applies to any email client using SMTP; however, if you are using Microsoft Outlook
linked to an Exchange server, you can access some more flexible features, as it is explained in section:
Faxing with Outlook using Exchange and the OpenTouch Fax Center Forms on page 62.

Fax Reception

Finally, if your OpenTouch Fax Center account was set for it, you can manage your incoming faxes and your
notifications for outgoing faxes directly in your email client (see Receiving Faxes and Notifications on page
52).

Sending a Fax with an Email Client Using SMTP

To send a fax with your email client:

1. Create a new email.
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2. Enter a subject and type the message, as you would do for an email.
They will be displayed on the cover sheet of your fax.

g~ Note: Plain textand HTML formats are supported in the message body for outgoing faxes. OpenTouch
Fax Center supports embedded images in HTML message body.

3. If needed, add attachments that will constitute the pages of the fax.
4. In the recipients field (To), enter the fax number with the following syntax:

fax=fax number@domain name
where:

» fax_number is the full fax number of the recipient to which you are addressing a fax.
* domain_name is the domain name used to redirect the message to the fax server of your company.

g~ Note: Your administrator should provide this domain name.

Tip: You can add a "+" sign in front of an international country code to apply the correct formatting

[
to the To: fax number on the Cover Sheet. However, the "+" sign feature may not be supported
depending on your phone company and/or the fax server configuration done by your administrator.
For example:

fax=5141234567@yourfaxdomain.com

Note: To know how to manage the content of the recipients field for more complex combinations,
see Managing Recipients on page 54.

[ N

5. If needed, you can change the cover sheet, the sender information and the fax options for the fax being
sent (see Changing the Cover Sheet on page 53 and Changing Sender Information and Fax Options on
page 53).

6. Send the fax as you would do for an email.

The fax is sent and you should receive by email a notification of fax sent if your OpenTouch Fax Center
account is configured to do so.

Note: For more information on managing notifications with your email client, see Receiving Faxes and
Notifications on page 52.

[ 1

Receiving Faxes and Notifications

If your OpenTouch Fax Center account was set for it, you should receive your incoming faxes and your
notifications for outgoing faxes directly by email in your email client.

Note: If you configured your e-mail client with a Reply To address (another e-mail address than the one
used to send faxes), all your outbound fax notifications will be sent to that address.

[ 1

All these notifications will appear like email messages with attachments. For example:
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B Fax Received from CSID: My Company - Pages received: 1 - Message (Plain Text)

! File Edit Miew Insert Format  Tools  Actions  Help

i Reply | ClReptytoal | cForward [ S o |4 | ¥ [ 23 X | @ - % - A |4 | @ H
From: administrator@mc, com Sent:  Wed 02/05/2007 1:01 PM
To Administrator

o
Subject:  Fax Received from CSID: My Company - Pages received: 1

Attachments: |2 66200292-AE18-4D07-A3B3-AA30588 1 DEBC-58-1F. tf (75 KB)

Pages Receiwved @1

Time Receiwved : Tuesday, May 1, 2007 3:25:03 PM ELT
Duration HIE 1=]

Remote C3ID 1 My Company

nID : 5551234567

g~ Note: The attachments you receive with the email notifications have the .tif or .pdf extension.

You can also display a list of your incoming and outgoing faxes using a Web browser (see Overview on page
81).

Changing the Cover Sheet

When your fax is being sent, the default cover sheet used depends on your OpenTouch Fax Center profile.
However, if you have enough rights, you can replace it by your own cover sheet or by another one available
on the Fax Server.

» If you wish to use a cover sheet located on your computer, you just need to attach it to the message being
sent, as any other attachment.

' Note: The file extension is: . cse. Cover sheets can be created or modified with the Cover Sheet
Editor (see Overview on page 71).

+ If you wish to use a different cover sheet among the ones available on the Fax Server, you must insert a
body code to the body of the message being sent (see Body Codes (Reference) on page 58).

Changing Sender Information and Fax Options

Typically:
» Sender Information (name, company...) can be displayed on the cover sheet of the fax.
» Fax Options define the way you wish to send the fax and receive notifications.

When your fax is being sent, sender information and fax options are retrieved from your OpenTouch Fax
Center account.

However, you can override or complete them — if you have enough rights for this — by using sender body
codes inserted in the body of the message. For more information on the body code concept and for the list
of available body codes, see Body Codes (Reference) on page 58.

g~ Note: Allthese changes will be applied only for the current fax and will not affect the data that are stored
in your OpenTouch Fax Center account and profile on the Fax Server.
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Managing Recipients

When you are composing a fax with your email client, you need to know how to manage adequately the
information you are going to enter about recipients. This section helps you to do it.

Adding a DTMF Code (Extension Number or Long-Distance Code)

If you need to add a DTMF code (such as an extension number or a long-distance code), you can enter it
after the fax number, preceded with one or several pauses (letter p — not case sensitive).

g~ Restriction: The comma, generally used for inserting a pause in most environments, is not supported
here.

For example:
fax=5141234567p9876Ryourfaxdomain.com

Adding Recipient Information

Information about recipients can be specified when sending faxes through email clients. This information (for
example, the name, the company, the job title...) can be useful for two reasons:

* |t can appear on the cover sheet of the fax.
» ltis stored with the fax in the OpenTouch Fax Center database.

g~ Note: Specifying recipient information is optional. Only the fax number is mandatory when you are
sending the fax.
You can specify recipient information in two ways:

* by using a dedicated syntax directly within the recipient field (i.e. the "To" field): see Adding Recipient
Information through the Email Recipient Field on page 54, or

» by adding recipient body codes within the email message body: see Adding Recipient Information through
the Email Message Body on page 57.

Adding More Recipients

It is possible to add more than one recipient to your fax:

+ To enter manually several recipients, you must separate them with a semi-colon. For example:
fax=5141234567@yourfaxdomain.com; fax=5149876543@yourfaxdomain.com

* You can also add real email addresses if you wish to send the same message by email to other recipients.
For example:

fax=5141234567Q@yourfaxdomain.com; Jjsmith@hiscompany.com

» Finally, you can add recipients from the address book of the email client. For more details, see Adding
Recipients from the Email Address Book on page 57.

Adding Recipient Information through the Email Recipient Field

You can specify recipient information directly through the recipient field ("To") of the email. To achieve this,
you need to respect a specific syntax, as described in this section.

g~ Note: If you are addressing your email to several fax numbers (multiple recipients), you can specify
recipient information for each entered fax number.
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Adding the Recipient Name Only

If you need to add only the recipient name, you can simply enter it by using the following smtp syntax:

"recipient name"<fax=fax number@domain name>

For example:
"John Smith"<fax=5141234567@yourfaxdomain.com>

As result, all the words between the quotes will be considered by the system as the first name of the recipient,
and the fax will be addressed according to the email address between the brackets < >.

g~ Note: In this syntax, the double quotes define what is called the Display Name of the email address.
Depending on your email client, you may be able to access the Display Name value again by double-click
or right-click (email properties), if you wish to modify it once the email address has been resolved in the
recipient field.

Adding Other Recipient Information
In general, the additional information is inserted through variables directly in the email address (for a given
recipient), using the following syntax:

fax=fax number/variable name=value/variable name=value@domain name
The rules are the following:

» The additional variables must be entered immediately after the fax number and before the domain name.

» Each additional variable must be preceded by a slash (/).

» The value of each variable must be indicated after the variable name, with an equal sign (=).

g~ Important: All recipient information values entered directly in the email address must only contain basic
ASCII characters. International/special characters (such as accented letters or non-latin characters) are

not allowed in these values. However, a solution exists: see Recipient Information Containing International
Characters on page 55.

For example:
fax=5141234567/fn=John/1n=Smith/jobtitle=Manager@yourfaxdomain.com

g~ Note: The first name and last name can be entered using this syntax. However, you can also mix the
syntaxes to enter the name as simple Display Name:

"John Smith"<fax=5141234567/jobtitle=Manager@yourfaxdomain.com>

Recipient Information Containing International Characters

If the recipient information contain international character (more generally, any character that is not part of
the basic ASCII characters set), you must enter them in the Display Name of the recipient, instead of entering
them directly in the email address, where these characters are not allowed.

Here are examples built according to the allowed syntaxes:

+ If you wish to indicate only the recipient name:

"Francois Légaré"<fax=5141234567@yourfaxdomain.com>

» If you wish to indicate the recipient name and other recipient information:
"/fn=Francois/ln=Légaré/jobtitle=Président"<fax=5141234567@yourfaxdomain.com>
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g~ Note: Evenifitis not recommended, it may happen that you define information in both the Display
Name and the email address. In case of conflict (same variable defined in both with a different value),
the value will be taken from the Display Name to override the one from the email address.

For example:

+ Display Name:/fn=Francois/1ln=Légaré/city=Montréal

¢ Email address: fax=5141234567/co=MyCompany/city=NewYork@yourfaxdomain.com

In that case, the system will use the information fn=Francois, 1n=Légaré, co=MyCompany and

city=Montréal.

Available Recipient Variables

All the variables available for adding recipient information are listed in the following table. Each of them

corresponds to a cover sheet placeholder, which is also indicated.

Variable Example Cover Sheet Placeholder
address address=123 Maple Street Street

bc, 0orbillingcode bc=Account 9876 Billing code
cellular cellular=5149876543 Cellular

city city=Montreal City

co, Or company co=My Company Company
country country=Canada Country

dear, dear=Mr. Dear

email email=jsmith@mycompany.com e-mail address
fn,or first, or firstname fn=John First name
1n,o0r last,or laststname In=Smith Last name
jobtitle jobtitle=President Title

phone phone=5149876542 Phone

pager pager=5149876541 Pager

state state=Quebec State

sbc, or subbillingcode sbc=6543 Sub billing code
zipcode zipcode=H1J 2K3 Zip code

The entered variables must correspond to placeholders of the cover sheet you are using. For example, if you
enter the cel1ular variable while the cover sheet template does not contain the corresponding placeholder,
the cellphone number of the recipient will not appear on the cover sheet. However, the information will be

recorded with the fax in the OpenTouch Fax Center database.

g~ Note: If you wish to create your own cover sheets or modify existing ones, please refer to the concerned
chapter (Overview on page 71).
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Adding Recipient Information through the Email Message Body

You can specify recipient information using recipient body codes inserted in the body of the message. For
more information on the concept of body codes and for the list of available body codes, see Body Codes
(Reference) on page 58.

g~ Restriction: If you are addressing your email to several fax numbers (multiple recipients), all recipients
of the fax will inherit from the same recipient information.

g~ Note: Itis possible to specify recipient information simultaneously through body codes and through the
recipient field ("To"). However, if the same recipient property is specified at both places, the value in the
recipient field will override the one of the body code.

Adding Recipients from the Email Address Book

Specific Contacts

If you wish to use your email client address book to add recipients to your faxes, you must create specific
additional contacts whose default email address is built according to the same syntax as for manual addressing
(see Sending a Fax with an Email Client Using SMTP on page 51):

fax=fax number@domain name

g~ Note: Remember that domain_name refers to the domain used to redirect the faxes to the Fax Server
of your company. Therefore, all the contacts of your address book used to send faxes should have an
email address ending with the same term.

For example:

Contact 1 fax=5141234567@yourfaxdomain.com
Contact 2 fax=4189876543Q@yourfaxdomain.com

Contact 3 fax=4506549630Q@yourfaxdomain.com

Email and Fax: Two Contacts

If you wish to have an email address and a fax number for the same person, you must create two separate
contacts and identify them according to their type.

For example:
Contact 1 John Smith (email) jsmith@hiscompany.com
Contact 2 John Smith (fax) fax=5141234567Q@yourfaxdomain.com

g~ Note: Itis possible to add email recipients and fax recipients to the same fax from the address book.

Recipient Information

Recipient information cannot be taken from the usual information fields of your address book, except the
content of the Display Name of the contact, which will be automatically interpreted by the system as the first
name of the recipient.
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However, you can indicate any recipient information within the email address by using the same syntax as
for manual addressing (see Adding Recipient Information through the Email Recipient Field on page 54).

Then, the default email address field of the contact can contain for example:
fax=5141234567/fn=John/1n=Smith/jobtitle=Manager@yourfaxdomain.com

g~ Important: All recipient information values entered directly in the email address must only contain basic
ASCII characters. International/special characters (such as accented letters or non-latin characters) are
not allowed in these values. However, a solution exists: see Recipient Information Containing International
Characters on page 55.

Body Codes (Reference)

Body codes are text expressions that you can insert to the body of the written email message in order to
specify various fax properties (or override existing defaults if you are allowed to).

Once you send your fax, the entered body codes are interpreted by the Fax Server (each specified value is
included in the corresponding fax metadata) and they disappear from the message body.

g~ Restriction: With Microsoft Outlook connected to a Microsoft Exchange server, the body of the email
where body codes are inserted must be in Plain Text format (not HTML).

This section is a reference providing:

» The syntax to use when including body codes to the email body.
» All available body codes, regrouped by context:

» Sender Information

* Fax Options

* Authentication

* Recipient Information

* Additional (Custom) Properties

The Body Code Syntax

The body codes must be entered with the following syntax:
@@body code=value

g~ Note: If the value term contains spaces or the < character, or if it is composed by Unicode characters,
you must enter the whole string between double quotes, in order for all chatacters of the value to be
correctly interpreted by the system. For example, if the city is Montreal, you can write
@@sendercity=Montreal, but if the city is New York, you must write @@sendercity="New York".

Body Codes for Sender Information

g~ Note: To use these body codes, you must have the rights to override your sender information. Contact
your administrator to know your faxing rights.

Body Code Description

@@csid Specifies your Call Station ID.
@@senderaddress Specifies your address.
@@senderbillingcode Specifies your billing code.
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Body Code Description

@@sendercellular Specifies your cellular phone number.
@@sendercity Specifies your city.
@@sendercompany Specifies the name of your company.
@@sendercountry Specifies your country.
@@senderemail Specifies your e-mail address.
@@senderfax Specifies your fax number.
@@senderfirstname Specifies your first name.
@@senderlastname Specifies your last name.
@@senderpager Specifies your pager number.
@@senderphone Specifies your telephone number.
@@sendersalutation Specifies a salutation like Mr. Ms. or prof.
@@senderstate Specifies your state or province.
@@sendersubbillingcode |Specifies your sub billing code.
@@sendertitle Specifies your title.
@@senderzipcode Specifies your postal code.

Sender Body Codes: Atomic Groups

Some sender body codes are part of what we call “atomic groups”. There are only two atomic groups of body
codes:

* The address information atomic group is composed of:

* (@@sendercompany
* (@@senderaddress
* (@@sendercity

* (@@senderstate

* (@@sendercountry

* (@@senderzipcode

» The phone information atomic group is composed of:

* (@@senderphone

* (@@senderfax

If even only one property of a group is specified with a body code, then all properties from this group are
taken from the message body, and not from your OpenTouch Fax Center account. Therefore, missing
properties are replaced with empty strings.

For example, if e@sendercompany=company name is included in the message body, then none of the other
elements that are part of the address information atomic group will be taken from your OpenTouch Fax
Center account. If their corresponding body codes are not present in the message, their values will be empty.

On the contrary, if none of the elements of an atomic group are specified in the message body, then the
values specified in your OpenTouch Fax Center account will be used.
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g~ Note: All the other body codes are not part of any atomic group. Therefore, their inclusion in the message
body does not have any impact on other properties.

Body Codes for Fax Options

g~ Note: To use these body codes, you must have the right to override your fax options. Contact your
administrator to know your faxing rights.

Body Code

Description

Accepted Values

@Rcoversheetname

Specifies the OpenTouch Fax Center cover sheet you wish to
use.

Important: This cover sheet must be one of the additional
cover sheets allowed for your Profile (if there are any).

[ N

Restriction: The default cover sheet of your Profile will not
be accepted here; if you wish to use it, just do not insert this
body code.

None, OF cs_name.cse

@@delayuntil

Enables a delay for sending the current fax and specifies the
date and time for this delay.

Any date/time value
formatted:
YYYY-MM-DDThh:mm: ss

@@notifybroadcast

Indicates whether you are to be notified by email for a broadcast
transmission (summary of all communications).

Note: Enabling this type of notification does not suspend
the other outgoing fax notifications. If you are using the
@@notifysuccess and @Rnotifyfailed body codes,
you will still receive notifications for all the fax
communications inside the broadcast.

[ 1

Yes or No

@@notifyfailed

Indicates whether you are to be notified by email if the
transmission fails.

Yes Or No

@@notifypreview

Indicates whether you are to receive a preview of the fax by email
before sending it.

Note: If this parameter is used when you send the fax, you
will receive a preview of the fax by email, but the fax will not
be sent to the recipient(s). To really send the fax to the
indicated recipient(s) after you receive the preview, you
must remove this parameter and send the fax again (you
must re-open your original fax from the sent items folder).

[ N

Yes Or No

@@notifysuccess

Indicates whether you are to be notified by email if the
transmission is successful.

Yes Or No

@Rresolution

Specifies the standard resolution at which the fax attachments
will be sent.

Note: The maximum available resolution value is set by
the administrator.

Low, High, Fine or
Ultrafine

@@sendpriority

Specifies the fax priority.

High, Normal, or Low
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Body Code

Description

Accepted Values

@@sendretries

[ 1

Note: You cannot exceed the maximum number of retries
specified by the administrator.

Specifies the number of retries to perform (when an error occurs, | 1 to 99
such as a busy signal).

@Qusebody

[ N

Specifies if the message body should be sent with the fax.

Note: This parameter overrides any profile restriction.

Yes Or No

Body Code for Authentication

If the administrator has set your OpenTouch Fax Center account for SMTP authentication, you will need to
enter your password in the message body by using the @epassword bodycode.

g~ Note: Contact your administrator to know your faxing rights.

For example: @eGpassword=MyPw1234

Body Codes for Recipient Information

Body Code

Description

@@recipientaddress

Specifies the address of the recipient.

@@recipientbillingcode

Specifies the billing code of the recipient.

@@recipientcellular

Specifies the cellular phone number of the recipient.

@Q@recipientcity

Specifies the city of the recipient.

@@recipientcompany

Specifies the company name of the recipient.

@Q@recipientcountry

Specifies the country of the recipient.

@@recipientemail

Specifies the email address of the recipient.

@@recipientfirstname

Specifies the first name of the recipient.

@@recipientlastname

Specifies the last name of the recipient.

@QRrecipientpager

Specifies the pager number of the recipient.

@QRrecipientphone

Specifies the telephone number of the recipient.

@@recipientsalutation

Specifies the salutation (like Mr. Ms. or prof.) of the recipient.

@@recipientstate

Specifies the state or province of the recipient.

@@recipientsubbillingcode

Specifies the sub-billing code of the recipient.

@@recipienttitle

Specifies the job title of the recipient.

@@recipientzipcode

Specifies the zip/postal code of the recipient.

Body Codes for Additional (Custom) Properties

If your administrator has set up the server to use additional (custom) fax properties and you are allowed or
intended to specify such properties when sending faxes, up to 5 body codes may be usable by you:
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* (@@customl
* (@@custom2
* (@Q@custom3
* (@Q@custom4

* (@@customb

g~ Note: These body codes must be specified as is, regardless to the corresponding property display names
that may have been configured on the server. Please contact your administrator to know the exact purpose
of each.

Faxing with Outlook using Exchange and the OpenTouch Fax
Center Forms

If you are using SMTP, the fax management with Outlook is the same as with any other email client (see
Faxing with Email Clients Using SMTP on page 51). However, if your Outlook is connected to a Microsoft
Exchange server and if your administrator configured the Exchange server for this, another protocol (MAPI)
can be used for a better management of your faxes.

Fax Composition

Additionally, some tools are available to make easier the fax composition: if they are installed, you can use
OpenTouch Fax Center forms for Outlook, or even the SendFax software. Also, the OpenTouch Fax Center
add-in for Outlook gives you a quick access to these composition tools.

Fax Reception

OpenTouch Fax Center forms for Outlook include a fax composition form, but also a preview form, and
notification forms for a better display of your received fax notifications (outgoing and incoming faxes; see
Receiving Faxes and Notifications with Outlook on page 64).

Using the OpenTouch Fax Center Add-In for Outlook

If your administrator installed the OpenTouch Fax Center add-in for MS Outlook, you should see a new button
in the MS Outlook interface:

with MS Outlook 2007 (or previous D] in the toolbar.

versions):

with MS Outlook 2010 (or more B under the Fax tab of the Outlook ribbon.
recent versions): }

This button gives a quick access to the interface with which you usually compose your faxes.

The fax composition interface that opens by clicking this button depends on the tools to which your administrator
gave you access. It can be (by decreasing priority):

1. The SendFax interface (if SendFax was installed on your computer)

2. The OpenTouch Fax Center composition form for Outlook (if the forms were published by the administrator
and SendFax was not installed)

3. The usual email composition interface of Outlook (if none of the two previous tools were installed)
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g~ Note: For more information on how to compose faxes with SendFax, see Overview on page 3. For
more information on how to compose faxes with MS Outlook (with or without the forms), see Sending a
Fax with Outlook Connected to an Exchange Server on page 63.

Sending a Fax with Outlook Connected to an Exchange Server

g~ Tip: If the Outlook add-in is installed, you can click the corresponding button to access directly your
usual fax composition interface (classic email or fax form). See Using the OpenTouch Fax Center Add-In
for Outlook on page 62 for more details.

Starting Without the Forms for Outlook

You can compose a fax as if it was a classic email, but the addressing must follow the syntax given in section:
Fax Addressing Syntax for Outlook on page 64.

Starting With the Forms for Outlook

If your administrator installed the OpenTouch Fax Center forms for Outlook, you can access a dedicated
interface (instead of the classic email composition interface) by selecting:

* For Outlook 2007: Tools [CEdrm [CHoose Form
* For Outlook 2010+: Home [CNdw Iltems [Mbre Iltems [Choose Form

The form to open is called Composition, in the Organizational Forms Library (library selected in the Look
in dropdown list), and appears as follows:
i Fle Edit ‘iew Insert Format  Tools  Acktions  Help

Psa5end | [ | & |goEtinns...E§Arial ~jw -|A|B I U|

111

ane
I
14

i=

Ul
=
il

i

Message Sender Info Delivery Opkions
To...
[EEaen

Subject: |

I E-mail me a preview Cover Sheet: <Ciefault= j

Then, you can compose your fax.

g~ Note: The addressing must follow the syntax given in the following section.
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Fax Addressing Syntax for Outlook

With or without the use of forms for Outlook, preparing a fax is still the same as by using any other email
client. The only — and important — difference resides on the syntax used to address the fax in the recipients
field (To), which is the following:

[FAX: fax number]

For example:
[FAX:5141234567]

g~ Note: The square brackets are mandatory.
g~ Tip: You can add a "+" sign in front of an international country code to apply the correct formatting to

the To: fax number on the Cover Sheet. However, the "+" sign feature may not be supported depending
on your phone company and/or the fax server configuration done by your administrator.

Optional Faxing Features
As for any fax sent with an email client, you can (with or without the forms):
» Enter a subject and a message.

g~ Note: Plain text, RTF and HTML formats are supported in the message body for outgoing faxes.
OpenTouch Fax Center supports embedded images in RTF/HTML message body.

» Attach documents that will constitute the fax pages.
» Add more complex entries in the recipients field (see Managing Recipients with Outlook on page 67).
» Change the cover sheet, the sender information and the fax options.

g~ Note: If you are using the forms for Outlook, you can benefit of specific interfaces for this (see
Changing Cover Sheet, Sender Information and Fax Options with Outlook on page 65). If not, you
will need to refer to sections: Changing the Cover Sheet on page 53 and Changing Sender Information
and Fax Options on page 53.

Authentication

If the administrator has set your OpenTouch Fax Center account for SMTP authentication, you will need to
enter your password in the message body by using the @epassword body code (see Changing Sender
Information and Fax Options on page 53).

g~ Note: Please contact your administrator to know your faxing rights.

Receiving Faxes and Notifications with Outlook

Without the Forms for Outlook

If the OpenTouch Fax Center forms for Outlook are not installed, your received faxes and the notifications
for your sent faxes will be displayed in the classic email interface, as for any email client using SMTP (see
Receiving Faxes and Notifications on page 52).

With the Forms for Outlook

If your administrator installed the OpenTouch Fax Center forms for Outlook, your received faxes and the
notifications for your sent faxes will be displayed in forms that are especially designed for this purpose.
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Note: If you configured Outlook with a Reply To address (another e-mail address than the one used to

[ i
send faxes), all your outbound fax notifications will be sent to that address.

For each type and status of the notifications you receive, the form is different, because of the nature of
information to display. Therefore, you may receive notifications with the following forms:

» Notification Incoming Failed

* Notification Incoming Success

» Notification Outgoing Failed

* Notification Outgoing Success

* Notification Broadcast

» Preview (when you receive a preview before sending the fax for real; see Receiving a Preview on page
66).

Note: Each of these forms contain tabs in which you can see information about the fax and the
communication.

[ 1

Also, when you receive a fax or a notification, a specific icon will distinguish its status in the list amongst all
your other emails (if the administrator activated the feature for your OpenTouch Fax Center account):

Icon  Notification

R Incoming fax that succeeded

#* Incoming fax that failed

& Outgoing fax that succeeded (or broadcast summary)
() Outgoing fax that failed

L8] Fax preview

Changing Cover Sheet, Sender Information and Fax Options with Outlook

Typically:

» Sender Information (name, company...) can be displayed on the cover sheet of the fax.
» Fax Options define the way you wish to send the fax and receive notifications.

If you have enough rights for it, you can change your cover sheet, your sender information and the fax options
in order to override your default ones (or complete them) for the fax being sent.

Note: All these changes will be applied only for the fax you are sending and will not affect the data that

&
are stored in your OpenTouch Fax Center account and profile on the Fax Server.

Without the Forms for Outlook

If you are using Outlook without the OpenTouch Fax Center forms, the Cover Sheet, Sender Information
and Fax Options must be managed as for any other email client using SMTP (with the same restrictions):

* You can override the selected cover sheet for your own one by adding a . cse file to the attachments of
the message.

* You can use body codes to override your sender information and fax options (including the cover sheet).
Fore more information, see Body Codes (Reference) on page 58
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With the Forms for Outlook

If your administrator installed the OpenTouch Fax Center forms for Outlook, you can access the available
tabs of the composition form to perform the same changes (see the following sections).

Changing the Cover Sheet

In the Message tab (see Starting With the Forms for Outlook on page 63), you can select one of the available
cover sheets of the Fax Server in the Cover Sheet dropdown list. If you leave <pefault>, the default cover
sheet associated to your profile will be used.

g~ Note: Still, you can override the selected cover sheet for your own one by adding a . cse file to the
attachments of the message (if you have enough rights).

Receiving a Preview

Also in the Message tab, you can check the E-mail me a preview box in order to receive a preview of your
fax.

g~ Note: If this box is checked when you send the fax, you will receive a preview of the fax by email, but
the fax will not be sent to the recipient(s). To really send the fax to the indicated recipient(s) after you
receive the preview, you must uncheck this box and send the fax again (to allow it, the email client cloned
and re-opened your original fax).

Changing the Sender Information

The Sender Information tab allows you to change your default personal information. You just need to check
the Use this information box and change the values of the fields.

g~ Note: By default, this box is unchecked, and the information is retrieved from your account on the Fax
Server.

i Fle Edit ‘iew Insert Format  Tools  Acktions  Help

 i=15end | o] | | 23 Optians. .. H | A|B I U |

1w
[
rl:
L.

Message Sender Info Delivery Options

Salukation |Mr j Phone |345-6?89
First Marne |John Fax |456—?89I:|
Last Marne |Smith Zellular |123-456?
Job Title |Director Pager |234-5678
Billing Code 030201 | E-mail | administr ator@vm2003-active ints
Sub Biling Code | 080504 =
Company |.ﬁ.cme City |Springﬁeld
Address 123 Main Street State [
Zip Code  [12345

Counkry ||_|Sp.
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Changing the Fax Options

The Delivery Options tab allows you to change the fax options. You just need to check the Use these
options box and change the options below.

[
Server.

Note: By default, this box is unchecked, and the settings are retrieved from your profile on the Fax

! File Edit Miew Insert Format  Tools  Actions  Help
fidgend | | 4 | 2] options... H

Message Sender Info Delivery Options

Priority Mormal -
Retries 3
Resaolution High -

I Broadcast natification
[ Motify on success

I Makify on Failure

I Delay Transmission Until: June 7, 2010 8:00 AM

Here is the description of the available options:

Notify on Success
Notify on Failure

Broadcast
Notification

Until:

Option Description
Priority Specifes the fax priority.
Retries Specifies the number of retries to perform (when an error occurs, such as a busy signal).
0 Note: You cannot exceed the maximum number of retries specified by the administrator.
Resolution Specifies the standard resolution at which the fax attachments will be sent.

Delay Transmission Enables a delay for sending the current fax and specifies the date and time for this delay.

. Note: The maximum available Resolution value is set by the administrator.

Indicates whether you are to be notified by email if the transmission is successful.
Indicates whether you are to be notified by email if the transmission fails.

Indicates whether you are to be notified by email for a broadcast transmission (summary of all
communications).

Note: Enabling this type of notification does not suspend the other outgoing fax notifications.
If you leave the Notify on success and Notify on failure boxes checked, you will still
receive notifications for all the fax communications inside the broadcast.

Managing Recipients with Outlook

When you are composing a fax with Outlook, you may need to know how to manage adequately the information
you are going to enter in the recipients field. This section helps you to do it.
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Adding a DTMF Code (Extension Number or Long-Distance Code)

If you need to add a DTMF code (such as an extension number or a long-distance code), you can enter it
after the fax number, preceded with one or several pauses (letter p — not case sensitive).

g~ Restriction: The comma, generally used for inserting a pause in most environments, is not supported
here.

For example:
[FAX:5141234567p9876]

Adding Recipient Information

You can add recipient information and associate it to the entered fax number, by using a dedicated syntax.
For more details, see Adding Recipient Information with Outlook on page 68.

g~ Note: Adding recipient information is optional. Only the fax number is mandatory when you are sending
the fax.

g~ Tip: Recipient information can also be specified using body codes, as for any other email client using
SMTP (with the same restrictions). See Adding Recipient Information through the Email Message Body
on page 57.

Adding More Recipients
It is possible to add more than one recipient to your fax:

» To enter manually several recipients, you must separate them with a semi-colon. For example:
[FAX:5141234567]; [FAX:5149876543]

* You can also add real email addresses if you wish to send the same message by email to other recipients.
For example:

[FAX:5141234567]; jsmith@hiscompany.com

» Finally, you can add recipients from the Outlook address book. For more details, see Adding Recipients
from the Outlook Address Book on page 70.

Adding Recipient Information with Outlook

As with other email cients, it is possible to add recipient information to the fax number of a given recipient
through the recipient field (i.e. the "To" field), in order to make them accessible for the Fax Server and possibly
the cover sheet of the fax. The usable recipient variables are the same as for SMTP, but the general syntax
is a bit different.

Adding the Recipient Name Only

If you need to add only the recipient name, you can simply enter it by using the following syntax:

[Fax:recipient name@fax number]
g~ Note: Everything that is put between the rax: word and the e sign is considered as the first name of
the recipient. The ¢ sign is mandatory when the recipient’'s name is specified.

For example:
[Fax:John Smith@5141234567]
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Adding Other Recipient Information

If you need to add for a given recipient more information than its name, you must use the following syntax:

[Fax:/variable name=value/variable name=value@Qfax number]
The rules are the following:

» All variables must be entered between the rax: word and the e sign.
» Each variable must be preceded by a slash (/), even the first one.
» The value of each variable must be indicated after the variable name, with an equal sign (=).

' Important: If you insert the recipient name with other information, you must indicate it with its
corresponding variable; the case described in the previous section (Adding the Recipient Name Only on
page 68) is no more applicable.

For example:
[Fax:/fn=John/ln=Smith/jobtitle=Manager@5141234567]

Available Recipient Variables

All the variables available for adding recipient information are listed in the following table. Each of them
corresponds to a cover sheet placeholder, which is also indicated.

Variable Example Cover Sheet Placeholder
address address=123 Maple Street Street

bc, 0orbillingcode bc=Account 9876 Billing code
cellular cellular=5149876543 Cellular

city city=Montreal City

co, Or company co=My Company Company
country country=Canada Country

dear, dear=Mr. Dear

email email=jsmith@mycompany.com e-mail address
fn,or first,or firstname fn=John First name
1n,0r last,or laststname In=Smith Last name
jobtitle jobtitle=President Title

phone phone=5149876542 Phone

pager pager=5149876541 Pager

state state=Quebec State

sbc, or subbillingcode sbc=6543 Sub billing code
zipcode zipcode=H1J 2K3 Zip code

The entered variables must correspond to placeholders of the cover sheet you are using. For example, if you
enter the cel1ular variable while the cover sheet template does not contain the corresponding placeholder,
the cellphone number of the recipient will not appear on the cover sheet. However, the information will be

recorded with the fax in the OpenTouch Fax Center database.

g~ Note: If you wish to create your own cover sheets or modify existing ones, please refer to the concerned
chapter (Overview on page 71).
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Adding Recipients from the Outlook Address Book

You can add to the recipients of your fax any contact of your personal contacts list of the Outlook address
book whose E-mail Type is FAX. They are considered as fax contacts and will receive automatically the
message as a fax.

g~ Note: Within the Outlook Address book, the same contact can have several email address and fax
numbers defined. For each of these entries, the contact will appear several times in your personal contacts
list — some for emails, of type SMTP, others for faxes, of type FAX. Therefore, there is no need to create
several contacts (emails and faxes) for the same person. Also, note that it is possible to add email
recipients and fax recipients to the same fax from the address book.

Depending on your needs, there are two ways to obtain fax contacts:

Using a Fax Field (Fax Number Only)

If some of your personal contacts have a fax number in one of their fields labelled “Fax” (Business Fax,
Home Fax or Other Fax), they will be automatically displayed as fax contacts in the list of available contacts
(in your personal contacts list).

g~ Note: In a fax field, no specific syntax is needed for the fax number.

Using an Email Field (Fax Number with Recipient Information)

Recipient information cannot be retrieved from the information fields of your Outlook contacts. However, It is
possible to use one of the email fields of the contact (instead of a fax field) to include recipient information
with the fax number.

For this, you must use the same syntax as for manual addressing (see Adding Recipient Information with
Outlook on page 68). Then, the second email field of your contact could contain for example:

[Fax:/fn=John/1ln=Smith/jobtitle=Manager@5141234567]

g~ Note: Once you entered this type of information in the field, the square brackets and the rax: word
disappear. This means that Outlook has well interpreted the email address as a fax information. You can
access the properties of the field (and modify its content if needed) by right-clicking on it: the E-mail
Type should be Fax.
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Chapter 8 Editing Cover Sheets

Overview

The Cover Sheet Editor offers the possibility of designing your own cover sheets for OpenTouch Fax Center
, and of modifying the existing ones provided with the Fax Server.

With the cover sheet editor, it is possible:

[ N

to draw geometric shapes
to add text and bitmap images
to add variables that automatically insert such information as sender name and company, etc.

to create, import, and link to OLE 2.0 (Object Linking and Embedding) compatible objects within the cover
sheet editor

to set several parameters as the resolution, the page format and the locale (language and date/time
format).

Note: Administrators can decide not to install the cover sheet editor on a user’s computer. It is possible
therefore that some users cannot access the module.

Launching the Cover Sheet Editor

Among your installed OpenTouch Fax Center applications, choose Cover Sheet Editor.

The cover sheet editor will be displayed, as depicted in the following screenview:
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Menu Bar Details and Associated Icons

The File Menu
0 New Allows you to create a new cover sheet.
= Open Opens a previously saved cover sheet.
=] Save Saves the current cover sheet.
Save As Saves your current cover sheet under a different name or in a different location.
= Print Prints the current cover sheet.
Print Displays cover sheet as it will look when printed.
Preview
Print Setup Sets print options.
Recent File Displays the filename of recently accessed cover sheet files.
Exit Closes the cover sheet editor.

The Edit menu

K Undo Erases the last action.

£ Cut Cuts (removes) the selected objects and puts them to the Clipboard, in order to paste
them somewhere else.

Copy Copies the selected objects to the Clipboard.
Paste Pastes the contents of the clipboard to your cover sheet.
Delete Deletes selected objects.
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) Insert New Lets you create, import and link to graphics, text, spreadsheets, etc., created with other
Object applications (see Embedding and Linking OLE 2.0 Objects on page 78).
Links Allows you to edit and update links (only for linked objects; see Managing OLE 2.0 Objects
in a Cover Sheet on page 78).
Object Lets you manage the selected OLE 2.0 object (see OLE 2.0 compatible objects on page
77).

The View menu

Toolbars Displays the main toolbar, the drawing toolbar, and the text attributes toolbar.
Status Bar Enables or disables the status bar at the bottom of the cover sheet editor window.
Grid Toggles the display of the grid points on the page.

Zoom Settings Lets you choose a different magnification setting to view your pages. By default,

the page is displayed at 100% (actual size).

Languages Enables the selection of language.

The Variables menu
There are three categories of variables used in cover sheets:

* General
* Sender
* Recipient

These variables are automatically filled in by OpenTouch Fax Center at the time of your fax transmission.

g~ Note: For more information, see Cover Sheet Variables on page 74.

The Settings menu

Page Setup Lets you chose the page size of the cover sheet (Letter, Legal, A3, B3 or A4) or
view the page dimensions by inches, pixels, or millimeters (see Setting the Page
Format on page 76).

Locale Allows you to set the locale which determines the date format and time that appears
on the cover sheet (see Setting the Cover Sheet Locale (Language and Date
Format) on page 76).

The Refresh feature

The Refresh button of the menu allows to refresh the current display of the cover sheet.

Creating a Cover Sheet

1. Open the cover sheet editor.

2. If needed, adjust the page format and locale settings for the current cover page (see Setting the Page
Format on page 76 and Setting the Cover Sheet Locale (Language and Date Format) on page 76).

3. Add and organize the items you wish to see appearing on the cover sheet:

» For geometric shapes, bitmaps and variables, see Adding and Editing Items on page 74.
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» For OLE 2.0 compatible objects, see OLE 2.0 compatible objects on page 77.
4. Choose Save As and type the name of your cover sheet.
The .cse extension is automatically applied.

Note: You can save the cover sheet with a specific resolution. For more information, see Setting the
Cover Sheet Resolution on page 77.

The cover sheet can now be used by the Fax Server.

g~ Note: Its integration is the responsibility of the administrator (see the OpenTouch Fax Center
Administration Guide).

Adding and Editing Items

It is possible to customize a cover sheet by adding and editing items such as text, lines, shapes and variables
through the toolbar:

alz Text Draws a text box on the currently displayed page. Type the text immediately
after drawing the box. Text boxes can be resized by clicking them and dragging
the handles.
LI Line Draws a line on the page.
El Rectangle or square Draws a rectangle or square on the page.
EI Rectangle or square with Draws a rectangle or square with rounded corners on the page.
rounded corners
EI Circle or ellipse Draws a circle or ellipse on the page
Variable Adds a variable on the page. Choose either General, a Sender, or a Recipient
variable.
e Note: For more information, see Cover Sheet Variables on page 74.

Polygon Adds a polygon. Click once and move the cursor to the next corner.

£l

e Note: Double-click to cancel a polygon entry.

EI Object Inserts, creates or links an object to the page. For more information, refer to OLE
2.0 compatible objects on page 77.

Cover Sheet Variables

There are three categories of variables used in cover sheets:

* General
+ Sender
* Recipient

These variables are automatically filled in by OpenTouch Fax Center at the time of your fax transmission.
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General Variables
General variables include:

» Time , Date

*  Number of Pages
» Subject

+ Commentary

* APltag, APl tag 2

Sender Variables
Sender information is defined in the fax sender's Information properties. Sender variables include:

» Dear, Display Name, First Name, Last Name
» Company, Title

» Street, City, State, Country, Zip Code

» Phone, Fax, Cellular, Pager, e-mail

» Billing Code, Sub Billing Code

Recipient Variables
Recipient variables, that is, variables concerning the fax recipient, include four categories:

* Name

* Address

* Destination
» Other

The following table lists the variables offered in each category. Note that Recipient information is defined in
the phone book.

Name Address Destination Other
Dear Street Destination Phone
Name City Fax Extension
Last Name State Fax 2 Cellular
First Name Zip Code Fax 3 Pager
Company Country e-mail Billing Code
Title e-mail 2 Sub Billing Code
e-mail 3 Phone Book Commentary
User 1
User 2
User 3
User 4

g~ Note: The menu selection Dear receives the value entered in the Salutation field in the phone book.
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Setting the Page Format

To access the page format settings dialog, just select Settings [Pdge Setup.

Page Settings ll
—Paper Setup
Paper size:
lLette Width: I 8.50
% Inches Height: I 11,00
" Pixels
" Millimeters

Ok I Cancel | Help |

There, you can change:

» The page format of your cover sheet, through the Paper size dropdown list.

g~ Note: The two dimensions of the selected size are displayed in the right of the dialog (in the
measurement unit selected below).

» The measurement unit used for the cover page (Inches, Pixels or Millimeters).

g~ Note: The cursor's coordinates (in the status bar of the editor) will be displayed in this unit.

Setting the Cover Sheet Locale (Language and Date Format)

You can choose locale settings that will be implemented in the cover sheet definition.

To access the locale settings dialog, select Settings [Ldcale.

Locale Information x|

—Standards and Formats

Locale:

English (Canada)

Time: IMedium ﬂ I

Date: |Sh-:-rt j |

Samples:

Time: |3:14:15 PM

Date: | 09-03-27

oK I Cancel

There, you can change:

The language (and country, with its usual locale settings) used for the current cover sheet, in the Locale
dropdown list.
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+ The Time and Date formats you wish to be used by the time and date variables you may have added to
your cover sheet.

g~ Note: You have access to several predefined formats that you can test by selecting them: the Samples
section will simulate the real output format with the current date and time.

Also, the custom format allows you to enter (in the field beside the dropdown list) your own format,
built according to the ICU 4.0 syntax (for more details, please refer to the Web page:
http.//icu-project.org/apiref/icu4c/classSimpleDateFormat.html, in the Detailed Description section).

Setting the Cover Sheet Resolution

Stand-alone fax machines usually have a lower resolution than laser printers. Your cover sheets may have
a slightly coarse appearance when printed by a fax machine.

You can apply a specific resolution to your cover sheet while you save it for the first time (or by selecting File
[Sdve As if the file exists already).

There, you can choose a resolution in the Resolution dropdown box at the bottom. Available choices are:

* Low resolution (200 x 100)

» High resolution (200 x 200), selected by default
* Fine resolution (300 x 300)

» Ultra Fine resolution (400 x 400)

' Note: Once the file is saved, the resolution is embedded in the cover sheet definition. Therefore, if you
wish to use a cover sheet with various resolutions, you must save each instance under a different name.
However, If you only need to change the resolution of an existing cover sheet, you must use the Save
As option and overwrite the file by using the same name.

OLE 2.0 compatible objects

Because the cover sheet editor is OLE 2.0 compatible, you can create, embed, or link to any OLE 2.0
compatible object created with a wide variety of third-party applications.

How it Works

When you create a new object, the application that is used to generate it is launched within the cover sheet
editor. An application window allows you to perform the necessary operations and the application’s menus,
toolbars, and status bar are integrated into the cover sheet editor window. Clicking outside the window, but
within the cover sheet, closes the application.

Examples of Applications

Among many others, objects placed in a cover sheet can be CorelDraw and Corel PhotoPaint graphics,
Microsoft Paint graphics, Microsoft PowerPoint slides, Word and WordPerfect documents, etc.

g~ Note: The application to generate the desired object type must be accessible from the computer running
the cover sheet editor.
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Embedding and Linking OLE 2.0 Objects

With the Cover Sheet Editor, an OLE 2.0 object can be either embedded (physically) in the cover sheet, or
linked to it by indicating the path to the object's physical location.

In both cases, you must click the EI button to start adding an object.

Adding an Embedded Object

When an object is embedded, it can be considered like any other item such as text, a geometric shape, a
bitmap image or a variable. However, an embedded object can be updated in the cover sheet editor: the
original application that was used to create the object is launched within the cover sheet editor.

When the Insert Object dialog opens, you have two choices:
» If you want to create an object from scratch and design it directly in the Cover Sheet Editor:

1. Select the Create New option.
2. Select the type of object you are going to create, then click OK.

The application associated to the type of object selected opens, and you can start designing the object.

g~ Note: When your object is finished, you just need to click in the cover sheet, outside the object.

» If you want to embed an object that already exists:

1. Select the Create from File option.
2. Browse for the wanted file, then click OK.

The object is added (embedded) to the cover sheet.

g~ Note: An embedded object is framed with solid lines.

Adding a Linked Object

When an object is linked, its location path and file name are only referenced from the cover sheet without
being physically embedded. Changes made to the linked object — outside the Cover Sheet Editor, using the
application that created it — are automatically reflected in the cover sheet.

When the Insert Object dialog opens:

1. Select the Create from File option.
2. Check the Link box.
3. Browse for the wanted file, then click OK.

The object is added (linked) to the cover sheet.

g~ Note: Alinked object is framed with dashed lines.

Managing OLE 2.0 Objects in a Cover Sheet

Editing an Object in a Cover Sheet

Itis possible to edit objects directly from the cover sheet, only by double-clicking them. However, the behavior
is slightly different depending on the status (embedded or linked) of the object:
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» If the object is embedded:

1. the application that created it opens inside the Cover Sheet Editor;
2. when your modification is done, you just need to click in the cover sheet, outside the object.

+ If the object is linked:

1. the application that created it opens independently, outside the Cover Sheet Editor;
2. when your modification is done, you need to save the object before closing its application.

g~ Note: Inthat case, be aware that the source file indicated by the link will be modified (not only in
the cover sheet).

Converting an Object
Depending on the supported formats, you can convert an object to another format.

When an object is selected, just select Edit ["Object_Type Object [_Cdnvert, then choose the target
format for conversion.

Note: Object Type is the type of the object selected. The possible conversions depend on this object
type.

[ N

Managing Links (Linked Objects only)

You can access the links management interface by selecting Edit [ Lihks.

Cancel

Update Mo |
Open Source |
LChange Source. .. |

Break Link |

Links: Type Update
T ; o

Source:  ChDocuments and SettingshadministratorsDesklopiuntitled. bmp
Type: Bitmap Image
Update: & Automatic ' Manual

All linked objects of the current cover sheet are listed in this interface.

Note: If a linked object was selected when you opened this interface, it will be selected by default in the
list. However, once the interface is open, you can select any other object of the list and manage its link
settings.

[ N

By default, linked objects in a cover sheet are updated automatically (option: Automatic). When the object
is changed through the application that created it, those changes are reflected immediately and automatically
in the cover sheet.

However, updating can be made manual (option: Manual). When manual updating is selected, the object
remains as it was when you originally linked to it. Changes are only applied to the original object, and not on
the object of the cover page. If you need to update the latter, you can use the Update Now.

For example, a logo already used as a linked object in a cover sheet is to be modified. You might change the
update from automatic to manual while these changes are being made. When the modifications are finished,
you can return to automatic updating, or maintain the manual update in anticipation of further changes.

8AL90087ENAA - Ed. 01 - August 2020 - OpenTouch Fax Center User Guide 79



Chapter 8 | Editing Cover Sheets

Through the same interface, you can also:

» Launch the application to edit the linked object (Open Source)
» Transform the linked object to an embedded object by breaking the link (Break Link)
» Change the link to point to another object (Change Source)
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Chapter 9 Web Client

Overview

OpenTouch Fax Center provides a browser-based interface for faxing and displaying the status of sent,
received and queued faxes. This interface is referred to by the term Web Client.

Terminology

The Web Client interface uses terminology and acronyms that are well known in the fax industry but may not
be familiar to most users. You may consult the lexicon at the end of this chapter to learn more about these
terms (see Lexicon on page 122).

Logging into the Web Client

Al o

. Launch your Web browser using the link or address communicated by your administrator.

Typically: http://<ServerName or IP>/fax
g~ Note: In HTTPS context, the syntax becomes: https://<ServerName>/fax

where <ServerName> must be the Common Name of the Fax Server (and not its IP address).

The Web Client login screen appears, as depicted in the following screenview.

Email Address :
Password :
Stay signed in

Login

g~ Note: If your system administrator has enabled access with your current NT account, you will have
automatic access to the Fax Status screen.

Enter your Email address (or SMTP address), as assigned by the system administrator.
Enter your Password.

If needed, check the Stay signed in box to access the interface more quickly on next logins.
Click Login.
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g~ Note: For security reasons, you may ocasionally be prompted to change your password before
accessing the Web Client interface. The default password policy is the following: 8 characters minimum,
including at least 1 uppercase letter and 1 number (unless another policy was defined by your
administrator).

Once you are logged in, the Inbound History page of the Web Client is displayed.

Search | Date | all
Ii2 Compose Fax ]
Folder view: Current | Deleted

0} Inbound History
0} Cutbound History

Forward = | | Delete | | More Actions | ™ | i

E Cutgoing Queue lto2of2
Received From: +15551111112
To: +15551111114
Received From: +15551111118

To: +15551111114

g~ Note: If you wish to access another user's fax box as Delegate (in the case this feature is available to
you), see: Accessing the Interface (of Another User) as Delegate on page 114.

Web Client Environment Description

Top Navigation Bar

Faxes Contacts john.smith@example.com | Options | Help | Logout

The top navigation bar includes the following items:

Menu Item Description
Faxes Gives access to the Folder Menu view (see The Fax Folders on page 84).
Contacts Gives access to the Contacts view which contains the phone books (see Web Phone Book

on page 118).

User name (email address) | Indicates the OpenTouch Fax Center user name corresponding to the currently logged-in

user.
Options Opens a dialog where several interface options can be changed (see Web Client Options
on page 83).
Help Launches an online help about the Web Client.
Logout Logs the current user out of the application.

Left Navigation Pane

The contents of the left navigation pane varies depending on the context, as described below:

Menu Item Description

Fax Box This drop-down list appears only if you are currently a Delegate for another OpenTouch
Fax Center user and allows you to switch between your fax box and the fax box(es) of the
user(s) for which you are a Delegate. For more details, see Accessing the Interface (of
Another User) as Delegate on page 114.
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Menu ltem

Description

Ii2 Compose Fax

The Compose Fax button located on the left side of the web user interface opens a page
from which you can configure, compose, and send faxes directly from a web browser. For
more details, see the following section: The Compose Feature on page 106.

Note: You may not have access to the Compose Fax button depending on your
faxing rights.

[

Fax Folders

Displayed when you select Faxes from the top navigation bar, the Inbound History,
Outbound History and Outgoing Queue folders allow you to access all faxes of the current
fax box (see The Fax Folders on page 84).

Phone Books and Groups

Displayed when you select Contacts from the top navigation bar, these folders allow you
to search and manage your phone book contacts (see Web Phone Book on page 118).

Web Client Options

The Options link gives access to the two options tabs described below.

[

Note: These two tabs are displayed only if your administrator enabled the Delegation feature. If not,

only the Options section (described here under the General tab) will appear.

General/User Options

General Delegation

User Options

Interface Language:

Fax Download Format:

English v

POF ¥

When sending a fax to new contacts

(@ Ask me if I want to add them to my Personal Contacts
() Add them to my Personal Contacts
(_) Do not add them to my Personal Contacts

Disable AutoComplete

Security

Change Password

Apply
Option Description Default
Interface Language | To change the display language of the interface.
Fax Download Format | To change the viewing format of faxes (TIF or PDF). PDF

When sending a fax to
new contacts

To configure the automatic adding of contacts to your phone book.

For more information refer to Configuring Automated Adding of
Contacts on page 121.

Ask me if | want to add
them to my Personal
Contacts

Disable Autocomplete

To disable the automatic selection of phone book contacts while
typing a name or fax number in the fields of the Compose tab.

Unchecked
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Security
Option Description Default
Change Password To change the password of your OpenTouch Fax Center account.
. Note: The default password policy is the following: 8 characters
~ minimum, including at least 1 uppercase letter and 1 number
(unless another policy was defined by your administrator).
Delegation

This tab allows you to:

1. Add other OpenTouch Fax Center users as Delegates.
2. Configure the permissions to give them access to your fax box.

For more information, see: Adding and Managing Delegates on page 113.

Among the applications you can install the Web Fax Composer Printer which can be useful when using the
Web Client. See Attaching Documents to a Fax by Using the Web Fax Composer Printer on page 115 for more
information on this feature.

The Fax Folders

In the Faxes window, the following folders are shown in the Navigation Pane:

* The Inbound History folder: Contains all the faxes that you have received. (see Inbound History Folder
on page 84).

+ The Outbound History folder: Contains all the faxes that you have sent (see Outbound History Folder
on page 93).

» The Outgoing Queue folder: Contains all the faxes that are in the process of being sent (see Outgoing
Queue Folder on page 99).

2 Compose Fax

0} Inbound History
0} Cutbound History
E Cutgoing Queue

To access the folder you wish to consult, click on the folder link in the Navigation Pane.

Inbound History Folder

The Inbound History folder contains two fax lists: one containing the current faxes (Current Folder View)
and another containing the deleted faxes (Deleted Folder View).

Inbound History - Current Folder View

In the Inbound History folder, you can select between the Current or Deleted folder view.
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The Current folder view displays the status of all the current faxes you have received. For more details
concerning the Deleted fax list, refer to /nbound History - Deleted Folder View on page 85.

Folder view: Current | Deleted

Search | Date [All

Forward = | Delete | More Actions |

=] status [l

;I Reset Advanced +

C

1to 26 of 26 Sort by Time ¥
Received From: +15551111112 4 Pages Mar 21
To: +15551111114
Received From: +15551111118 2 Pages Mar 21
To: +15551111114
Received From: +15551111120 2 Pages Mar 21
To: +15551111114
Received From: +15551111116 4 Pages Mar 21
To: +15551111114

The Inbound History fax folder has the following controls:

» Search Feature: Above the Current | Deleted links you will find the Search fields and buttons. Refer to
Searching Inbound History Records on page 103 for more information on this feature.

» Sort Feature: To the right of the folder is a Sort feature. See Sorting the Fax List on page 102 for a
description of this feature.

+ Fax Management Buttons: Directly above the fax list are three buttons: Forward, Delete and More
Actions. These buttons allow you to manage your faxes. See Managing your Inbound Faxes on page 85.

» Fax List: The fax list contains all the faxes you have received. Basic information is displayed for each fax:

* The received fax status;

* The From: information or Remote CSID;

* The To: information or destination fax number;

* The number of pages contained in the fax, and,;

» The date of reception (or the time if received on the current day).

Clicking on any fax will display the fax details. See Viewing the Inbound Fax Details on page 89 for a
description of this function.

g~ Note: Eachtime a fax is viewed (unless it is done several times within a short time by the same
person), the action is logged in the fax Event Log (see Inbound Event Log on page 92).

Inbound History - Deleted Folder View

The Inbound History Deleted folder view displays the status of all inbound faxes that were deleted.

Folder view: Current | Deleted

Restore | | Forward = | | Delete | | More Actions | ~

The Inbound History Deleted folder view has the same functionalities as the Inbound History - Current Folder
View, but with the addition of a Restore button. See Managing your Inbound Faxes on page 85.

Managing your Inbound Faxes

The Inbound History Current folder view offers a user various options to manage faxes.
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Forward = | | Delete | | More Actions | ™ ]
l1to 7of 7 Sort by Time ¥
Received From: +15551111112 4 Pages Mar 21
To: +15551111114
Received From: +15551111118 2 Pages Mar 21
To: +15551111114
Received From: +15551111120 2 Pages Mar 21
T+ L1ECC111111 4
Button Description
Forward This button allows you to forward one or several received faxes to one or several subsequent
recipients.
It is actually a full feature that includes several user friendly options such as recently used
and favorite destinations, and fax drag-and-drop for quick forwarding (see Forwarding Faxes
on page 86).
Note: Faxes can be forwarded from the Current or Deleted views of the Inbound
History.
. Note: When a fax has been forwarded, an icon is shown beside the checkbox.
Delete In Current Folder View: Clicking on the Delete button removes the selected fax(es). Deleted
faxes can be viewed in the deleted folder view.
In Deleted Folder View: Clicking on the Delete button permanently deletes the selected
fax(es).
Restore ONLY In Deleted Folder View: Clicking on the Restore button returns the selected fax(es)
to the Inbound History - Current Folder.
More Actions > Mark as | When a fax is unread, it is flagged as bold text. Once viewed, it is flagged as unbold text.
viewed The user can select whether a fax is marked as viewed or unviewed without opening the
- fax(es) by simply clicking the Mark as viewed or Mark as unviewed button.
More Actions > Mark as
unviewed
Select All Check Box Checking the check box below the buttons will select all the faxes shown in the folder.

The process is straightforward, simply select one or more faxes by checking the box(es) to the left of all the
fax entries in the Inbound History window and then click on the appropriate button depending upon the desired

action.

g~ Note: Each time an action of the above table is performed, it is logged in the Event Log of the fax (see
Inbound Event Log on page 92).

Forwarding Faxes

Faxes can be forwarded from the Inbound History (either in Current or Deleted view):

Starting the Forwarding

Before selecting recipients, you have two options to start the forwarding action:

» Check the box at the left of the line (of one or several faxes), then click Forward, or

Directly drag the fax (or a multiple selection of faxes) to the Forward button using the handle () at the

left of the line.

86
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The Forward Button/Menu
In all cases, the Forward button will deploy a menu from which you can select destinations for:

* Quick forwarding (see Quick Forwarding on page 87).
» Advanced forwarding (see Advanced Forwarding on page 88).

Quick Forwarding

You can benefit from several features and options allowing you to quickly forward faxes to your most used
destinations.

However, as these features depend on your actual fax forwarding activity, you may first need to go several
times through the advanced forwarding window before obtaining an effective quick-forward environment (see
Advanced Forwarding on page 88).

Quickly Available Destinations

The Forward menu contains — among other options — a list of the most recent destinations you may have
used for forwarding faxes, and a list of destinations you may have tagged as favorites (see Managing the
Favorites on page 87).

Forward

* & Laser Printer

w [Z3 Accounting
'i:? g jane.doe@example.com
‘7.:3 g robert. pepper@example. com

g james.blacki@example.com

More...
Detach

Selecting a destination in one of those lists (by click on fax selection or by fax drag-and-drop) will instantly
forward the concerned faxes to this destination.

g~ Note: If you wish to forward the same fax to several destinations, you need to repeat the same action
with all concerned destinations, or you can perform this in one single action by selecting More.

Managing the Favorites

Everywhere a destination is listed in the interface via the Forward feature (in the Forward menu or in the
advanced forwarding window), a clickable star is displayed at its left for allowing to add it as Favorite or
remove it from the list of Favorites.

The full list of Favorites is displayed in the Forward menu, above the Recently Used destination list.

Repetitive Forwarding to Various Destinations

If you need to repetitively forward faxes to various destinations, for example when you are in charge of
distributing faxes received via a single fax number to various internal recipients of your company, this operation
can be facilitated by selecting Forward [Ddtach before starting forwarding faxes.
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Forward

iz Laser Printer
a jane. doe@example.com

a john smith@example.com

a robert. pepper@example. com
Mare...

Close

This way, you have all the content of the Forward menu permanently available in a detached window, allowing
you to quickly drag-and-drop faxes to any of your recent or favorite destinations.

Advanced Forwarding

By selecting Forward ["Mare, you access a window from which several more specific and advanced actions
can be performed.

Select Destinations

Search: All El

bob.ponge@example.com No data available in table
jane.doe@example.com

sebastien.dune@faxserver.com

john.smith@example.com

robert.pepper@example.com

Accounting

{r [ o o o e o

Laser Printer

Forward Cancel

Forwarding the Fax Selection to Several Destinations

Once you access this screen, you just need to click on the available destinations of the left list to add them
to the right — in order to build a list of destinations to which the fax selection will be forwarded — and then click
Forward.

g~ Note: If you selected a destination by mistake, just click on it in the right list to remove it from the selection.

Searching Available Destinations

You can search destinations by entering characters in the Search field: the list below will instantly be updated
to display only destinations whose name contains (anywhere in the name) the entered sequence of characters.

Filtering the Available Destinations

The available destinations can be of different types (fax users, folders, printers...). You can filter them by type
using the drop-down list at the right of the Search field. All types are displayed by default.
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Viewing the Inbound Fax Details

To view the details of a received fax, just click on the concerned fax entry in the Inbound History.
The inbound fax details are divided in five tabs:

» Fax (see Inbound Fax Tab on page 90)

* Properties (see Inbound Properties Tab on page 90)

* Routing History (see Inbound Routing History Tab on page 91)
* Note (see Inbound Note Tab on page 92)

» Event Log (see Inbound Event Log on page 92)

Back Download | | Forward Delete More Actions | *

Fax Properties Raouting History Note Event Log

E @ l«f /11 C €1~ t 0=

20013/10/31 11307 (A ;I

[ FrOM

Name:  Admin Robert Pepper

The following controls are available in the Fax Details View:

+ Back link: Returns to the folder view;
+ Download button: Downloads the fax TIFF file to your local drive;

g~ Note: This button will be grayed out unless your administrator enabled the Download feature. If the
feature is enabled while you are logged in your account, you may need to log out and log back in for
the button to take effect.

» Forward button: Same functionality as Forward button in folder view (see Managing your Inbound Faxes
on page 85);

» Delete button: Same functionality as Delete button in folder view (see Managing your Inbound Faxes on
page 85);

* Restore button (ONLY in Inbound History - Deleted Folder View): Same functionality as the Restore
button in folder view (see Managing your Inbound Faxes on page 85);

» More Actions > Print Fax Information button: Opens the web browser print dialog to print the fax
Properties, Routing History and Note together;

+ More Actions > Mark as unviewed button: Once a fax has been viewed, it is flagged as unbold text.
Using this button, the user can return the fax to unviewed status (bold text).

g~ Note: Each time an action of the above list is performed, it is logged in the Event Log of the fax (see
Inbound Event Log on page 92).

g~ Restriction: You may not have access to the Download and/or Print Fax Information buttons depending
on your faxing rights.
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Inbound Fax Tab

The Fax tab shows the content of a received fax. The contents of the fax cannot be edited.

@« /11 C €1~ 1 [0 %

2013/10/31 113007 11 il

| From |

Mame:  Admin Robert Papper

The following controls are available:

Page Layout icons : Clicking on these icons have the following effect (from left to right):

» View fax in page mode (for reading)
» View fax in thumbnail mode (for global overview and page selection)

. 1 i1
Page Selection controls € =

or through an input field.

: On multiple-page faxes, selects the page number with arrows

Page Rotation icons ¢ ¢ . Clicking on these icons have the following effect (from left to right):

* Rotate all pages by 180 degrees (upside down)
* Rotate the current page by 180 degrees (upside down)

o,
Y

75}

Page Zoom controls = 1 '

» Fit horizontally in the window
» Fit vertically in the window
» Zooms the page(s) with a sliding control or through percentage input in field

Inbound Properties Tab

The Properties tab shows the fax information. See Lexicon on page 122 for fax specific terminology and
acronyms.

90
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Fax Properties Routing History MNote Event Log

General Information

Status Received

From (ANI) 5145551234

To (DID) 5141112222

Transaction ID 57819A5B-13B7-43E7-990F-2C3B927FF368-238-1F

Transmission Information

Remote Fax Identifier (CSID)

Fax Transmis=sion Duration 46 seconds (at 14400 bps)

Time and Size Information

Received Time Jun 19 2012 11:38 AM Less info
Archived Time Jun 19 2012 11:38 AM

Pages Received 1

Additional Properties

If your administrator has set up the server to use and show additional (custom) fax properties, they appear
at the bottom of this same page, as shown in the following example:

Custom

Customl A-1234
Custom2 rFal @ or Cancel

Note: The actual section title, as well as the actual labels of these additional properties will depend on
the setup that was done by your administrator, according to their specific purpose within your organization.

Some of these properties may be read-only while others may be editable (identified with a pencil icon). If you
are allowed or intended to edit such properties, just click on the pencil icon, enter or modify the value and
click Save.

Note: Each time a custom property is modified (by you or a delegate of your Fax Box or an administrator),
the action is logged in the fax Event Log (see Inbound Event Log on page 92).

Inbound Routing History Tab

The Routing History tab lists the routing information and history for this fax

Fax Properties Raouting History Note Event Log

Received From Fax System @

Forwarded To

Uzer From : john.smith@example.com

To : jane.doe@example.com Operation completed successfully

Uzer From : john.emith@example.com

To : richard.smith@example.com COperation completed successfully

Uzer From : john.smith@example.com

D = T T A e s Operation completed successfully

g~ Note: The fax may have been forwarded several times or to several destinations; in all cases, all
forwarding information will be listed under this tab.
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Inbound Note Tab

The fax Note tab allows users to add personal text notes to Inbound and Outbound faxes.

g~ Note: Forexample, a user can use the fax Note as content reminders or as keywords for search queries.
The window can contain a maximum of 2500 characters per fax note.

Fax Properties Routing History Note Event Log
MNote

Reminders, search items or a note to a colleague.

Click the Save button to save the text. The text contained in the fax notes follow the fax when forwarded to
other OpenTouch Fax Center users.

g~ Note: Each time a fax note is saved, the action is logged in the fax Event Log (see Inbound Event Log
on page 92). The saved note content will appear among the logged information, where it will be visible
only by the author of the note and by authorized administrators.

Inbound Event Log

The Event Log tab displays all events that occurred and all actions that were performed on the current fax.

g~ Note: This tab may be unavailable depending on your faxing profile rights but will always remain available
to authorized administrators.
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Fax Properties Routing History Note Event Log
Date and Time Action By
Friday, March 13 2015 4:27 PM Fax received @ Fax System
Friday, March 13 2015 4:27 PM Email notification Fax System
Friday, March 13 2015 4:27 PM Routed to user Fax System
Friday, March 13 2015 4:27 PM Fax viewed john.smith@example.com

Date and Time: Mar 13 2015 04:27:34 PM
By: Fax System

Action:

Routed to user

Destination: john.smith@example.com

Export

An inbound fax event log will include the following:

1. All system success and failure events related to:

Fax reception (by the system)
Fax routing and notifications (to recipient and other destinations)

2. Any action performed by users (including delegates) and administrators, such as:

Fax viewed or downloaded

g~ Note: If the same user/administrator views the fax several times within a short period, the action
may not be logged several times (due to a temporary caching process).

Fax marked as viewed or unviewed
Fax forwarded or rerouted

Fax deleted or restored

Fax note saved

Fax custom property modified

Each event/action is logged with its date, summary and originator name. Additional information may be
available below the log when selecting a specific event/action.

Exporting the Fax Event Log

The fax event log can be exported/downloaded through a Microsoft Excel file (. x1sx file named after the fax
transaction ID). This file contains all detailed information on all events/actions of the current fax.

Outbound History Folder

The Outbound History folder contains two fax lists: one containing the current faxes (Current Folder View)
and another to contain the deleted faxes (Deleted Folder View).
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Outbound History - Current Folder View

In the Outbound History tab, you can select between the Current or Deleted folder view.

The Current folder view displays the status of all the current faxes that you have sent. For more details
concerning the Deleted view, refer to Outbound History - Deleted Folder View on page 94.

Search | Date | All El Status | All El Reset Advanced +
Folder view: Current | Deleted
Rezubmit Delete More Actions |~ (&}
ltoSof 5 Sort by Time ¥
Sent First Draft 2 Pages 2:15 PM

To: +15551111118

Sent First Draft 2 Pages 2:15 PM
To: +15551111116

Sent Report 5 Pages Mar 21
To: +15551111120

Sent Request 1 Page Mar 21
To: +15551111112

The Outbound History fax folder has the following controls:

» Search Feature: Above the Current | Deleted links you will find the Search fields and buttons. Refer to
Searching Inbound History Records on page 103 for more information on this feature.

» Sort Feature: To the right of the folder is a Sort feature. See Sorting the Fax List on page 102 for a
description of this feature.

+ Fax Management Buttons: Directly above the fax list are three buttons: Delete, Resubmit and More...
. These buttons allow you to manage your faxes. See Managing your Outbound Faxes on page 95.

» Fax List: The fax list contains all the faxes you have sent. Basic information is displayed for each fax:

» The sent fax status;

* The fax subject;

* The To: information or destination fax number;

» The number of pages contained in the fax, and;

» The date sent (or the time if sent on the current day).

Clicking on any fax will display the fax details. See Viewing the Outbound Fax Details on page 96 for a
description of this function.

g~ Note: Each time a fax is viewed (unless it is done several times within a short time by the same
person), the action is logged in the fax Event Log (see Outbound Event Log on page 98).

Outbound History - Deleted Folder View

The Outbound History Deleted folder view displays the fax status of all outbound faxes that were deleted.

Folder view: Current | Deleted

Restore || Resubmit || Delete | | More Actions | ~

The Outbound History Deleted folder view has the same functionalities as the Outbound History - Current
Folder View, but with the addition of a Restore button. See Managing your Outbound Faxes on page 95.
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Managing your Outbound Faxes

The Outbound History Current folder view offers a user various options to manage faxes.

Resubmit Delete More Actions | ™ &)
1to50of5s Sort by Time ¥
Sent First Draft 2 Pages 2:15 PM
To: +15551111118
Sent First Draft 2 Pages 2:15 FM
To: +15551111116
Sent Report 5 Pages Mar 21
Th: 215551113190
Button Description
Resubmit Click the Resubmit button to resubmit faxes:

» Either to the same numbers — by default, without entering a new number.

» Or to different number(s) — by entering them in the dedicated field.

» Possibly with a (new) transmission delay — by entering a Date and Time after having
checked the Delay Transmission Until feature.

Resubmit
Please enter the fax number you wish to send vour faxes to :
5141234567

Delay transmission until :

Diate: Wednesday, August 08, 2012 | ¥ | Time: 14:00 hd

Resubmit Back

After validation, the selected fax(es) will be sent to the Outgoing Queue for processing.

Note: If your administrator has set up the server to use additional (custom) fax
properties, the resubmitted faxes will include the current values of the original faxes
at the time the resubmit action occurs (except values resulting from barcodes, which
are always re-scanned).

Delete In Current Folder View: Clicking on the Delete button removes the selected fax(es). Deleted
faxes can be viewed in the deleted folder view.
In Deleted Folder View: Clicking on the Delete button permanently deletes the selected
fax(es).

Restore ONLY In Deleted Folder View: Clicking on the Restore button returns the selected fax(es)

to the Outbound History - Current Folder.

More Actions > Mark as
viewed

More Actions > Mark as
unviewed

When a fax is unread, it is flagged as bold text. Once viewed, it is flagged as unbold text.
The user can select whether a fax is marked as viewed or unviewed without opening the
fax(es) by simply clicking the Mark as viewed or Mark as unviewed button.

Select All Check Box

Checking the check box below the buttons will select all the faxes shown in the folder.
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[ N

[ N

Note: Each time an action of the above table is performed, it is logged in the Event Log of the fax (see
Outbound Event Log on page 98).

Restriction: You may not have access to the Resubmit button depending on your faxing rights.

Viewing the Outbound Fax Details

To view the details of a sent fax, just click on the concerned fax entry in the Outbound History.

The outbound fax details are divided in four tabs:

Fax (see Outbound Fax Tab on page 97)

Properties (see Outbound Properties Tab on page 97)
Note (see Outbound Note Tab on page 98)

Event Log (see Outbound Event Log on page 98)

Back Download || Resubmit Delete More Actions |~

Fax Properties MNote Event Log

E = |« /11 C €1 » t 0%

)

| From |

Name:  Admin Robert Papper

Phone: Fa +15551111114 LI

The following controls are available in the Fax Details View:

Back link: Returns to the folder view;
Download button: Downloads the fax TIFF file to your local drive;

g~ Note: This button will be grayed out unless your administrator enabled the Download feature. If the
feature is enabled while you are logged in your account, you may need to log out and log back in for
the button to take effect.

Resubmit button: Same functionality as Resubmit button in folder view (see Managing your Outbound
Faxes on page 95);

Delete button: Same functionality as Delete button in folder view (see Managing your Outbound Faxes
on page 95);

Restore button (ONLY in Outbound History - Deleted Folder View): Same functionality as the Restore
button in folder view (see Managing your Outbound Faxes on page 95);

More Actions > Print Fax Information button: Opens the web browser print dialog to print the fax
Properties and Note together;

More Actions > Mark as unviewed button: Once a fax has been viewed, it is flagged as unbold text.
Using this button, the user can return the fax to unviewed status (bold text).

96
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g~ Note: Each time an action of the above list is performed, it is logged in the Event Log of the fax (see
Outbound Event Log on page 98).

g~ Restriction: You may not have access to the Download, Print Fax Information and/or Resubmit
buttons depending on your faxing rights.

Outbound Fax Tab

The procedure for displaying the contents of an outbound fax in a browser window is the same as the one
for an inbound fax. For details, refer back to the section, Inbound Fax Tab on page 90.

Outbound Properties Tab

The Properties tab shows the fax information. See Lexicon on page 122 for fax specific terminology and

acronyms.

Fax Properties MNote

General Information

Status
Subject
Diestination
Transaction ID
Broadcast ID
Sender
Sender Billing Code
Recipient Name
Transmission Information
Remote Fax Identifier (CSID)
Fax Transmission Duration
Time and Size Information
Completed/Failed Time
Submitted Time
Archived Time
Pages

Additional Properties

Event Log

Sent

Contract

5141112222 (originally 514-111-2222)
7BBABEBE-872D-46CC-A936-AD990ES25607-462-0F
7BBASSBE-872D-46CC-A936-AD990ES25607-460-BR.
john.smith@example.com

Users

Robert Pepper

Less info

5141112222

46 seconds (at 14400 bps)
Jun 21 2012 01:56 PM Less info
Jun 21 2012 01:55 PM (took 46 seconds to process)

Jun 21 2012 01:56 PM

1 page sent

If your administrator has set up the server to use and show additional (custom) fax properties, they appear
at the bottom of this same page, as shown in the following example:

Custom
Customl

Custom2

B e

g~ Note: The actual section title, as well as the actual labels of these additional properties will depend on
the setup that was done by your administrator, according to their specific purpose within your organization.

Some of these properties may be read-only while others may be editable (identified with a pencil icon). If you
are allowed or intended to edit such properties, just click on the pencil icon, enter or modify the value and
click Save.

g~ Note: Each time a custom property is modified (by you or a delegate of your Fax Box or an administrator),
the action is logged in the fax Event Log (see Outbound Event Log on page 98).
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Outbound Note Tab

The fax Note tab allows users to add personal text notes for Inbound and Outbound faxes. For more details,
refer to Inbound Note Tab on page 92.

Outbound Event Log

The Event Log tab displays all events that occurred and all actions that were performed on the current fax.

g~ Note: This tab may be unavailable depending on your faxing profile rights but will always remain available
to authorized administrators.

Fax Properties MNote Event Log

Date and Time Action By

Friday, March 13 2015 3:26 PM Fax submitted to the server john.smith@example.com
Friday, March 13 2015 3:26 PM Fax transmission success ﬂ Fax System

Friday, March 13 2015 3:27 PM Email notification @ Fax System

Friday, March 13 2015 3:27 PM Fax viewed john.smith@example.com
Friday, March 13 2015 4:27 PM Fax resubmitted john.smith@example.com

Date and Time: Mar 13 2015 03:26:50 PM
By: john.smith@example.com
Action: Fax submitted to the server

Export

An outbound fax event log will include the following:
1. All system success and failure events related to:

* Fax submission (to the system)
» Fax transmission (to the recipient)
» Fax notifications (feedback)

2. Any action performed by users (including delegates) and administrators, such as:

« Fax/broadcast transmission canceled or retried
» Fax viewed or downloaded

' Note: If the same user/administrator views the fax several times within a short period, the action
may not be logged several times (due to a temporary caching process).

» Fax marked as viewed or unviewed
* Fax resubmitted

* Fax deleted or restored

+ Fax note saved

» Fax custom property modified
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Each event/action is logged with its date, summary and originator name. Additional information may be
available below the log when selecting a specific event/action.

Exporting the Fax Event Log

The fax event log can be exported/downloaded through a Microsoft Excel file (. x1sx file named after the fax
transaction ID). This file contains all detailed information on all events/actions of the current fax.

Outgoing Queue Folder

The Outgoing Queue folder contains only one fax list. Faxes are going to remain in this folder until the
sending process is complete.

Outgoing Queue Folder View

The Outgoing Queue folder displays the status of faxes that are currently being sent or waiting to be sent.

Search | Date | All [=] Pricrity | Al [=] Reset Advanced ¥
Retry now | | Cancel |+ &)
1to 2 of 2
Sending First Draft 0/2 Pages 2:14 PM
To: +15551111116
Sending First Draft 0/2 Pages 2:14 PM

To: +15551111118

The Outgoing Queue fax folder has the following controls:

» Search Feature: At the top of the window you will find the Search fields and buttons. Refer to Searching
Inbound History Records on page 103 for more information on this feature.

+ Fax Management Buttons: Directly above the fax list are two buttons: Cancel and Retry now. These
buttons allow you to manage your faxes. See Managing your Queued Faxes on page 100.

» Fax List: The fax list contains all the faxes you have submitted. Basic information is displayed for each
fax:

» The queued fax status;

» The fax subject;

» The To: information or destination fax number;

* The number of pages contained in the fax, and,;

+ The time sent or, if sending with a delay, the time (if the same day) or date it will be sent.

g~ Note: You will need to refresh the page to see the progress of a fax being sent.

Any fax for which the destination has returned a busy signal: the fax remains in the queue until OpenTouch
Fax Center issues a retry.

Any fax for which you entered a transmission delay (for scheduled faxing): the fax remains in the queue
with the pelayed status until the scheduled date is reached.

Clicking on any fax will display the fax details. See Viewing the Outgoing Queue Fax Details on page 100
for a description of this function.

g~ Note: Eachtime a fax is viewed (unless it is done several times within a short time by the same
person), the action is logged in the fax Event Log (see Outbound Event Log on page 98).
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Managing your Queued Faxes

The Outgoing Queue view offers a user various options to manage faxes, by using buttons such as: Cancel,
Cancel Broadcast, and Retry now. Refer to the following screenview, as well as table, for an overview.

Retry now Cancel - &)

lto2of 2

Sending First Draft 0/1 page 06:17 pm
To: +15551234567

Ready to send First Draft 0/1 page 06:17 pm
To: +15551236789

Button Description

Retry now When a fax(es) is in the Waiting to Retry status mode, this can be caused by a temporary
(busy fax line) or permanent error (hardware or software problems) detected by the
XMFaxDriver. As soon as this error is corrected, the system switches the status mode to
Ready to Send. When the user clicks the Retry now button, the system executes immediately
and bypasses the retry delay mode.

Cancel Click Cancel to cancel the transmission of the selected fax(es).

Cancel Broadcast Check the box to the left of any fax entry in the Outgoing Queue window that is part of the

broadcast that you want to cancel and then click the Cancel Broadcast button.

Note: A fax broadcast occurs when an OpenTouch Fax Center user addresses the

€
same fax to two or more recipients. Each fax in the broadcast is listed individually in
the outgoing queue. You can cancel one or several of these faxes as just described,
or cancel the entire broadcast.
Select All Check Box Checking the check box below the buttons will select all the faxes shown in the folder.

g~ Note: Each time an action of the above table is performed, it is logged in the Event Log of the fax (see
Outbound Event Log on page 98).

g~ Tip: The only way to change the schedule date/time for a delayed fax is to cancel this fax from the

Outgoing Queue and then resubmit it from the Outbound History (see Managing your Outbound Faxes
on page 95).

Viewing the Outgoing Queue Fax Details

To view the details of a queued fax, just click on the concerned fax entry in the Outgoing Queue.

g~ Note: Eachtime afax is viewed (unless it is done several times within a short time by the same person),
the action is logged in the fax Event Log (see Outbound Event Log on page 98).

The inbound fax details are divided in two tabs:

» Fax (see Outgoing Fax Tab on page 101);
» Properties (see Outgoing Properties Tab on page 101);
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Back Download | | Retry now More Actions | ¥

Fax Properties

E = |« /11 C €1 » t 0%

)

| From |

Name:  Admin Robert Papper

Phone: Fa +15551111114 LI

The following controls are available in the Fax Details View:

» Back link: Returns to the folder view.
» Download button: Downloads the fax TIFF file to your local drive;

g~ Note: This button will be grayed out unless your administrator enabled the Download feature. If the
feature is enabled while you are logged in your account, you may need to log out and log back in for
the button to take effect.

* Retry Now button: Same functionality as Retry Now button in folder view (see Managing your Queued
Faxes on page 100);

» More Actions > Print Fax Information button: Opens the web browser print dialog to print the fax
Properties;

* More Actions > Cancel / Cancel Broadcast button: Same functionality as Cancel / Cancel Broadcast
button in folder view (see Managing your Queued Faxes on page 100);

g~ Note: Each time an action of the above list is performed, it is logged in the Event Log of the fax (see
Outbound Event Log on page 98).

g~ Restriction: You may not have access to the Download and/or Print Fax Information buttons depending
on your faxing rights.

Outgoing Fax Tab

The procedure for displaying the contents of an outgoing fax in a browser window is the same as the one for
an inbound fax. For details, refer back to the section, Inbound Fax Tab on page 90.

Outgoing Properties Tab

The Properties tab shows the fax information. See Lexicon on page 122 for fax specific terminology and
acronyms.
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Fax Properties

Fax Information

Status Sending after 1 out of 4 possible attempts

Subject Contract

Diestination 5141112222 (originally 514-111-2222)

Transaction ID 7BBASSB3-872D-46CC-A936-AD990ES525607-571-0F m}r
Broadcast ID 7BBABSB3-872D-46CC-AS36-AD9S0ES25607-570-BR

Sender john.smith@example.com

Recipient Mame Robert Pepper

Transmission Information

Remote Fax Identifier (C5I0)

Fax Transmission Duration M/
Time and Size Information

Submitted Time Jun 21 2012 02:12 PM (queued for 4 seconds) More info Ji
Fages 1 page submitted

g~ Note: Even if your administrator has set up the server to use additional (custom) fax properties, they
will not appear among outgoing fax properties on this page. However, you will be able to see them among
outbound fax properties (see Outbound Properties Tab on page 97).

Sort and Search Features

These two tools will help you organize and browse through your faxes.

You can sort your faxes by various pre-defined values and search through them using different variables.

Sorting the Fax List

The Sort feature allows you to sort the fax list according to pre-defined values. When the cursor is above the
underlined bold text, the list of values is shown. Select the desired value to sort the list. If you click on the
triangular arrow, the sort will be inverted.

1to 5of 5 Sort by Time ¥
Status
Received From: +15551111112 1 Page
To: +15551111114 Time
Received From: +15551111118 1 Page Tao
To: +15551111114
i From
Received From: +15551111120 1 Page
To: +15551111114
Received From: +15551111116 1 Page 11:42 AM

The list of values shown in the figure is for the Inbound History folder. The Outbound History folder have the
following values available:

+ Status

* Subject
+ Time

« To

g~ Note: The Outgoing Queue folder does not have this feature.
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Searching the Fax List

You can display all, or a specific selection of faxes, in any of the three folder by using the search bar at the
top of the browser.

Searching Inbound History Records

Inbound History Simple Search

The simple search toolbar (seen below) contains one search field and two drop-down lists.

Search | Date [ All = status [Al =] Reset Advanced ¥

Text Search

The field allows you to enter a keyword that can locate a specific set of faxes in the inbound history archive.
The search is performed in all of the property fields of the Fax Details, including the additional properties
(custom fields) that may have been enabled by the administrator.

g~ Restriction: The content of the fax image (in the Fax tab) is not searchable.

g~ Note: The search is not case sensitive.

The user has the search capability of including or excluding specific keywords in a search expression much
like a search engine. The following table provides further details on search parameters that can be used in
this field.

Operator |Description

+ - The + and - operators indicate that a word is required to be present or absent, respectively, for a match to
occur. The operators must be placed before (without a space) the word. e.g. +xxx -yyy.

* The asterisk serves as the truncation (or wildcard) operator. It should be appended to the word to be affected.
Words match if they begin with the word preceding the * operator.

" A phrase that is enclosed within double quote (" ") characters matches only rows that contain the phrase
literally, as it was typed. The full-text engine splits the phrase into words and performs a search for the
words. Non-word characters need not be matched exactly. Phrase searching requires only that matches
contain exactly the same words as the phrase and in the same order. For example, "test phrase" matches
"test, phrase".

g~ Note: The simple search is designed to ignore specific "generic" words called Stop words such as the,
or, again, etc. These Stop words can be modified to add or remove specific words that may interfere
with the nature of the search. Consult with your system administrator for further information.

Note: In simple search, a word is defined as any sequence of letters, digits, underscores but only 1
apostrophe in a row. For example:

¢ Qaaa'666 is considered as 1 word
« a'b'c65 is considered as 1 word
« a"abcdb is considered as 2 words
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Once all your criteria selected, click on the Search button. Leaving the search field empty and the drop-downs
to All will result in all the faxes being displayed (see Date and Status drop-downs below).

g~ Note: If you have made a selection within the drop-downs, the search feature will search only among
the filtered faxes. To search through all the faxes, select All in both drop-downs.

Date Filtering

The Date drop-down allows you to filter faxes based on the following criteria: the fax was received at any
time or within a certain time range.

Click on the desired time range. Selecting Custom opens the Custom date range menu where you can
specify another range of dates. You can narrow it down even more by specifying a start time on the begin
date and a finish time on the end date. The times can be selected in 15-minute increments.

Filtering is implemented as soon as a drop-down list item is selected or when the OK button is clicked in the
Custom Date Range Menu.

Custom date range menu

Begin Date: Monday, July 16, 2012 - Begin Time: 07:00 -
End Date: Wednesday, July 18, 2012 - End Time: 17:15 -
Ok Cancel

Status Filtering

The Status drop-down allows you to view all the current faxes, or filter the faxes to only see either the received
or partial/failed ones. As soon as a selection is made, filtering of the faxes is implemented.

Inbound History Advanced Search

For a search related to a specific field of the fax, click on the Advanced link.

Advanced Search Hide ¥
From (ANI) To (DID) Extension
Remote CSID Note Fax ID
Error Code
Date [All = Status [All =]

Search  Reset

Enter the search values in the fields of your choice.
g~ Restriction: Additional properties (custom fields) that may have been enabled by the administrator are
not included in advanced search.

In the advanced search, the search value must match the entire content of the related field. If searching in
the From field, one would enter, for example, 5142221111 as the fax number instead of only 2221111, as the
latter would not produce any hits.

g~ Note: The search is not case sensitive.
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The or operator (in upper case) can be used in these fields to search for alternate criteria.
The Date and Status drop-downs function in the same manner as in simple search.

Note: See the Lexicon on page 122 for fax specific terminology and acronyms used in the advanced
search.

[ 1

Searching Outbound History Records

Outbound History Simple Search

The Outbound History simple search functions in the same way as the Inbound History simple search. See
Inbound History Simple Search on page 103.

Search | Date [ All = status [l =] Reset Advanced

Outbound History Advanced Search

The Outbound History advanced search functions in the same way as the Inbound History Advanced Search
on page 104, but the search fields are different.

Adwanced Search Hide ¥
Destination Subject Remote CSID
Recipient Nate Fax ID
Name
Billing code Error Code
Date [All | Status [All =1

Search | peset

Restriction: Additional properties (custom fields) that may have been enabled by the administrator are
not included in advanced search.

[ 1

Searching Outgoing Queue Records

Simple Search

The Outgoing Queue simple search functions in the same way as the Inbound History simple search. See
Inbound History Simple Search on page 103.

Search | Date | All E| Priority [ All El Reset Advanced +

g~ Note: There are a few differences here, compared to the Inbound and Outbound History:

» The Status drop-down is replaced by the Priority drop-down. It allows you to indicate if you want to
view all the outgoing faxes, or only either the ones with High, Normal or Low priority.

» Even if your administrator has set up the server to use additional (custom) fax properties, they will
not be searchable from the outgoing queue. However, you will be able to search them from the
outbound history.
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Advanced Search

The Outgoing Queue advanced search functions in the same way as the Inbound History Advanced Search
on page 104, but the search fields are different.

Adwanced Search Hide ¥
Diestination Fax ID
Date |All =] Priority | All =1

Search | peset

The Compose Feature

The Compose Fax button opens a page from which you can configure, compose, and send faxes directly
from a web browser.

Compose Interface Description

Tabs

The Compose page contains three tabs: Compose (default), Sender & Company Information, and Options.
They are used in Creating and Sending a Fax on page 110.

Buttons

The Submit button located above the tabs transmits the fax.

g~ Note: You may not have access to the Submit button depending on your faxing rights.

The Preview button makes the fax server generate a preview of your fax before sending.
g~ Note: This operation (which involves image conversion on the server side) may take some time to
complete depending on the number of pages of the attachments.

The preview screen offers the same display options as the ones available when viewing a sent or received
fax (see Inbound Fax Tab on page 90). From this screen, you can either submit your fax or get back to the
composition screen to perform changes.

N Attention: Clicking the Compose Fax button will reset all fields and cancel the fax you were preparing.

[£LI

The Compose Tab

In the dialog of the Compose tab, users can specify the recipient(s) of the fax, modify the cover page, and
include file attachments.
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F Submit 42 Praview

Compose Sender & Company information Options

Recipients

MName: “ More recipients...

Company:

Fax:

Cover Sheet
Style: Default Cover Sheet (BasicO0l.cse) ¥
Subject:

Comment:

Attachments

Document to attach
Choose File | Mo file chosen

More attachments...

In the Recipients section, the following fields are available:

Name The name of the recipient(s).
Company The organization where the recipient(s) works.
Fax The fax destination number.

' Tip: You can add a "+" sign in front of an international country code to apply the correct
formatting to the To: fax number on the Cover Sheet. However, the "+" sign feature may
not be supported depending on your phone company and/or the fax server configuration
done by your administrator.

g~ Note: To add (and manage) one or more recipient, refer to Adding One or More Recipients to a Fax on
page 111.

In the Cover Sheet section, the following fields are available:

Style Select a cover sheet to append to the memo (the default cover sheet is Basic01.cse). If you
don’t want to append a cover sheet, select None.

Subject The subject of the fax memo.

Comment The main text message of the fax.

In the Attachments section, users can attach one or more files to the fax. For more information, refer to
Adding One or More Attachments to a Fax on page 111.

You can also add attachments by using the Web Fax Composer Printer. See Attaching Documents to a Fax
by Using the Web Fax Composer Printer on page 115.
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g~ Note: Although the Web Fax Composer Printer opens the Web Client Compose Feature, it can be used
with the Web Client already open and will add attachments to the current fax. It will do so even if there
are already attachments in the current fax.

Sender and Company Information Tab

The dialog for the Sender & Company Information tab is where you specify your Personal Information,
Billing Information, and Company Information. It is possible to use the information provided in the profile
associated with your user account, or directly specify custom information. Refer to the following screenview
for a depiction.

Compose Sender & Company information Options

(@ Use default sender and company information
()Use custom sender and company information

Personal Information

Salutation: E-mail: john.smith@example.com
First Name: Mobile:

Last Mame: Pager:

Jaob Title:

Billing Information

Billing code:
Sub Billing Code:

Company Information

Company: Fhone:
Address: Fax:
City:

State:

Country:

Zip Code:

Restore defaults

Select the Use default sender and company information option to use the billing and company information
specified in the profile associated with your user account. The personal information will remain empty, except
for the e-mail address.

Select the Use custom sender and company information option to customize the personal, billing, and
company information for the fax. If you select this option, you can enter data in the following fields:

Salutation: A standard greeting. For example: Mr., Miss, Madam.
First Name: The sender’s first name.

Last Name: The sender’s last name (surname).

Job title: The sender’s job title.

E-Mail: The sender’s e-mail address.

Mobile: The sender’s cellular phone number.

Pager: The sender’s pager number.

Billing Code: The sender’s billing code.
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Sub Billing Code:
Company:
Address:

City:

State:

Country:

Zip:

Phone:

Fax:
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The sender’s sub billing code.

The sender’s company name.

The sender’s company address (number and street).

The city where the sender’s company is located.

The state or province where the sender’s company is located.
The country where the sender’s company is located.

The sender’s company ZIP or postal code.

The sender’s company phone number.

The sender’s company fax number.

Clicking Restore defaults restores the fields to the values taken from the user’s profile. If no value is specified
in the profile, or if the field is part of the Personal Information section (except for the e-mail), the field is

cleared.

The Options Tab

You can specify the fax settings and whether you want to receive notifications in the dialog of the Options
tab. Refer to the following screenview for a depiction.
Compose Sender & Company information Options

(@ Use default options
()Use customn options

Options

Priority: Mormsl
MWurmber of retries: 3
Resolution: High

Matify on success
Matify on failure
Broadeast notification

Restore defaults
Delay
Delay Transrission Until:

Date: 15/2/2013 hd Time: 10:00 -

Select the Use default options option to use the fax settings specified in the profile associated with your
user account.

Select the Use custom options option to customize the fax settings. If you select this option, you can enter
data in the following fields:

Priority:

Number of retries:

Resolution:

Notify on success:

Specifies the fax priority (Low or Normal). The default is Normal.

Specifies the maximum number of times the gateway tries to transmit the fax
before failing. The default is 3; the maximum is 99.

Specifies the fax resolution (High or Low). The default is High.

Check this box to issue a notification after a fax is sent successfully.
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Notify on failure: Check this box to issue a natification when the sending of a fax fails.

Broadcast Notification: Check this box to enable the reception of a single notification (summary) after
a broadcast fax emission.

g~ Note: Enabling this type of notification does not suspend the other
outgoing fax natifications. If you leave the Notify on success and Notify
on failure boxes checked, you will still receive notifications for all the
fax communications inside the broadcast.

Delay Transmission Until: Check this box if you wish to delay the sending of the current fax, then select
a date and time for the delay.

Clicking Restore defaults restores the fields to the values taken from the user’s profile. If no value is specified
in the profile, the field is cleared.

Creating and Sending a Fax

To use this feature, you must have faxing rights.

To create and send a fax using the Compose feature of the Web Client, perform the following steps:

1. Click Compose Fax.
2. In the Compose tab, enter the Name, Company and Fax Number of a recipient.
- Tip: If you need to add a DTMF code (such as an extension number or a long-distance code), you

can enter it after the fax number, preceded with one or several pauses (comma or letter p — not case
sensitive).

For example: (514) 222-3333p1234 (equivalentto (514) 222-3333,1234).

g~ Note: If you need to add (and manage) more than one recipient, refer to Adding One or More
Recipients to a Fax on page 111.

The Name, Company and Fax Number fields offer automated entries from the Web Phone Book when
you start to enter a value.

3. Enter the Subject of the fax.
4. Enter the actual text of the message in the Comment section.

5. If you need to use a specific cover sheet, select a cover sheet in the Cover Sheet drop-down list, or select
None if you do not wish to append one to the fax.

6. If you want to join an attachment to the fax, refer to Adding One or More Attachments to a Fax on page
111.

7. If you need to modify the sender and company information or the settings for the current fax, refer to
Sender and Company Information Tab on page 108 and The Options Tab on page 109.

8. Click the Submit button, located above the Compose feature's tabs.
g~ Note: You can generate a preview of your fax before sending. This operation may however take

some time depending on the number of pages to preview. See Compose Interface Description on
page 106 for more details.

When submitting a fax the Web Client confirms the sending status with a Broadcast Id confirmation similar
to the following:
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Fax submitted

Fax successfully queued for delivery; Broadcast ID is 8B91A850-8E08-
4518-989D-EB496ACCCo36-11-BR

New Recipients

The following recipients do not exist in your personal contacts, please
check the contacts you want to add:

[T 1zhn Smith, 514-123-4567

Ok

g~ Note: You can add a contact to your personal phone book when a fax is sent. However, this action can
be configured beforehand. For more information see Configuring Automated Adding of Contacts on page
121

Adding One or More Recipients to a Fax

How to add one or more recipient to a fax being sent, and how to manage the list of recipients.

This procedure takes in consideration that you are preparing a fax before sending it. For more information
about sending a fax, refer to Creating and Sending a Fax on page 110.

To add one or several recipients to your fax:

1. In the Compose tab, enter the Name, Company and Fax Number of a recipient.

2. If you need to add more than one recipient, click the More recipients button.
A new section appears to the right of the Recipients fields.

Wearos Clorenty; Fex MNurdser
Add of

Edit |
Rermoue |

3. Enter the recipient's information in the information fields then click Add when done.
4. Repeat this operation for every fax recipient.
5. If you need to modify the information of a recipient already in the list:

a) Select a recipient in the list and click Edit.

g~ Note: If the fields already contain information, clicking Edit will erase this information.

The information of the selected recipient appears in the corresponding fields on the left and the recipient
disappears from the list.

b) Modify the information in the fields and click Add to validate.
The modified recipient appears again in the list.

6. If you need to delete a recipient from the list, select a recipient then click Remove.

Adding One or More Attachments to a Fax

How to add one or several attachment to a fax being sent.

This procedure takes in consideration that you are preparing a fax before sending it. For more information
about sending a fax, refer to Creating and Sending a Fax on page 110.
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To add one or several attachments to your fax:

1. Click Browse and select a file to upload to the fax.

2. If you need to add more than one attachment, click the More attachments button.
A new section below the Browse field opens.

Attachments

| Browse...
Uploaded attachments Add
C:W\Documents and Settings'jplanci\DesktophCV_2007_06.pdf

Ci \Documente and Settinge‘\jpleno‘Desktop'lew Text Document.txt Remove

Click Browse and choose the file you wish to upload to the fax then click Add.

Repeat this operation for every fax attachment.

Use the Move Up and Move Down buttons to modify the order of the attachments.

If you need to delete an attachment from the list, select an attachment then click Remove.

L

g~ Note: You can also add attachments by using the Web Fax Composer Printer. See Attaching
Documents to a Fax by Using the Web Fax Composer Printer on page 115.

Although the Web Fax Composer Printer opens the Web Client Compose Feature, it can be used
with the Web Client already open and will add attachments to the current fax. It will do so even if there
are already attachments in the current fax.

Delegation

OpenTouch Fax Center gives the users the ability to delegate other OpenTouch Fax Center users for
accessing their fax box, for example while they are on vacation.

As long as the Administrator has enabled the Delegation feature (please refer to your Fax Server administrator
if not), two types of users roles can be defined in the Delegation context: the Owner and the Delegates.

Owner

This term defines all OpenTouch Fax Center users who have access to their own fax box via the Web Client
interface. As Owners, they have access to all features that the Administrator has granted them to use (see
Overview on page 81).

An Owner can delegate one or several OpenTouch Fax Center users (called here Delegates) for accessing
his/her fax box. The Delegates access is configurable (many options between full and very restricted access)
and can be different from one Delegate to another.

For more information about Delegates management, see: Adding and Managing Delegates on page 113.

Delegates

This term defines all OpenTouch Fax Center users who have access to their own fax box via the Web Client
interface and who have been selected by another OpenTouch Fax Center user (called here the Owner) to
access precisely this user's fax box, in a Delegation context.

Depending on the specific permissions that the Owner gave to a Delegate, this Delegate may have full powers
or restricted access regarding the Owner's fax box and its features.
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g~ Note: OpenTouch Fax Center users can be the Delegate of multiple Owners.

For more information about the interface access as Delegate, see: Accessing the Interface (of Another User)
as Delegate on page 114.

Adding and Managing Delegates

The following procedure assumes that:

* You are already logged in the Web Client interface, under your own fax box.
* Your Administrator enabled the Delegation feature.

To add a Delegate and configure the permissions for the access to your fax box:

1. Click the Options link in the top-right corner of the interface.
The Options screen appears.

2. Select the Delegation tab.

General Delegation
Delegaticn
Delegates Add
User Email Start Date Edit
Remove
3. Click Add.
Delegate
User Email Check Email

Show only first page

Has access to compose

Has access to permanent delete
Has access to resubmit

Has access to forward

AAAS

Add Cancel

4. In the User Email field, start to type the user account name of the person you wish to add as Delegate,
then click Check Email.
Depending on the first letters you entered, the system may complete the name in the field or allow you to
select an item among a list of available users whose account name start with these letters.

g~ Important: It is recommended to use the Check Email button in order to verify if the entered user
account name exists, otherwise you will not benefit from the expected delegation.

Tip: If you are not able to find or remember existing user account names, you can still leave the User
Email field empty and simply click Check Email to access the list of all available users.
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5. Setup the delegation permissions you wish to give to this specific Delegate:

Option Name Description Default
Show only first page |Restrains the Delegate to view no more than the first page of any fax in your | Disabled
box.

Has access to Allows the Delegate to compose faxes from your box. Enabled
compose
Has access to Allows the Delegate to delete faxes from the Deleted views of your box. Enabled
permanent delete
Has access to Allows the Delegate to resubmit faxes from your Outbound History. Enabled
resubmit
Has access to Allows the Delegate to forward faxes from your Inbound History. Enabled
forward Note: All forwarding operations will be tagged with the name of the

Delegate in the Routing History of the concerned fax (see Viewing the

Inbound Fax Details on page 89).

g~ Note: All actions performed on a fax by a delegate are logged in the Event Log of the fax (see
Inbound Event Log on page 92 or Outbound Event Log on page 98).

6. Click Add.
The new Delegate appears now in the list of Delegates and the targeted user is now able to access your
fax box according to the permissions you selected. The delegation Start Date is also shown for future
reference.

You can now add and configure other Delegates if needed, or manage the list of existing ones using the Edit
and Remove buttons.

g~ Note: The Start Date will not change upon the edition of permissions within an existing delegation.

Accessing the Interface (of Another User) as Delegate

The following procedure assumes that:

* Your Administrator enabled the Delegation feature.
» At least another OpenTouch Fax Center user has added you as Delegate.

To access the fax box of another user as Delegate:

1. Logon into the Web Client interface with your own account.
In the top-left corner of the interface, you should see the Fax Box drop-down list, allowing you to switch
between your fax box (at the top of the list) and the fax boxes of all users who added you as Delegate.

Fax Box
|jchn.5mﬂh@example.ccm LI

jehn.smith{@example.com
jane. doe@example.com
robert. pepper@example.com

eﬁ Inbound History
eﬁ Qutbound History
E Outgoing Queue

2. Select a user in the drop-down list.
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You are now in the fax box of the selected user, and you can act there according to the specific permissions
this user gave to you as Delegate.

g~ Restriction: Delegation permissions that you may have are only for faxing features (see the list of
options in section: Adding and Managing Delegates on page 113). You will never have access to the
Options section of another fax box than your own.

g~ Note: All actions performed on a fax by a delegate are logged in the Event Log of the fax (see
Inbound Event Log on page 92 or Outbound Event Log on page 98).

g~ Tip: To go back to your own fax box, just select your account name in the Fax Box drop-down list.

Attaching Documents to a Fax by Using the Web Fax Composer
Printer

If the Web Fax Composer Printer is installed on your computer, you can send faxes via the Web Client interface
by printing documents from any Windows application.

When using the Web Fax Composer Printer, the document is converted into a TIFF file and attached to a fax
in the Web Client Compose feature.

Open the document to be faxed with the appropriate application.
Access the print option of the application.
Select the Web Fax Composer printer in the list of available printers.

Print the document.
The document is transformed into a TIFF file and the Attachment Preparation window opens. The TIFF
file is visible in the Progress box.

PoOobd-=
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‘ Web Fax Composer - Attachment Preparation E
Language: IEninsh j

—Fax Server Connection Setkings

Hosk Marme or LRL: I MyFaxServer

r— Authentication

" Use windows Integrated Single Sign-on

% |se Basic Suthentication

sername: I john.smithi@exanple.com

EESE S ST 22
Password: I

¥ Remember passward
[ Auto Upload

—Progress
Receiving doc001 ki { 1 pages ) ... Done! ;I

Print more documents ar upload your printed selection,

Ipload I Cancel |

5. Enter your connection and authentication settings (if not already set).
For more information, see Connection and Authentication Settings on page 117.

6. Click Upload.
A Web Client Interface session opens in composition mode with your TIFF file added as an attachment.

g~ Note: If a fax was already in preparation in the web interface, the TIFF file is attached to this fax.

g~ Note: To upload more than one attachment at a time and for upload automation, see Upload Options
on page 116

7. To complete fax composition and send your fax in Web Client, see .

Upload Options

Auto Upload Option

If you usually upload only one attachment at a time to the Web Fax Composer, you can check the Auto
Upload box. When you print from your Windows application, the Attachment Preparation window will open
and will start uploading immediately.

The Cancel button will then become a Close button which will include a 10-second countdown once the TIFF
attachment has been uploaded. You can click Close at any time to close the window.

g~ Note: When the Auto Upload option is activated, this prevents the user from modifying the settings
(connection, authentication, language). To disable it, uncheck the box during the 10-second delay the
next time you use the Web Fax Composer printer.
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Uploading More than One Attachment

g~ Note: The Auto Upload box must be unchecked to use this method.

Once one file has been transformed to a TIFF file in the Attachment Preparation window, do not click Upload
at this time. Return to your Windows application or use any other Windows application to print another file

through the Web Fax Composer Printer. The TIFF file will be added in the Progress box of the Attachment
Preparation window.

Repeat this as many times as required until all the attachments you require are in the Progress box, then
upload to the Web Fax Composer. All the attachments will be present in the Web Client Compose feature.

g~ Note: If you want to upload an additional attachment after the upload, print and upload the file and it will
be simply added to the list of attachments in the Web Client Compose feature.

General Settings

Interface Language Selection
Use the drop down list to instantly change the language used in the Attachment Preparation window.

g~ Note: The default setting is Use My Regional Settings.

Connection and Authentication Settings
The connection and logon settings are mandatory for being able to use the feature.
Fax Server Connection Settings:

._ .!'-.,_] Attention: This Host Name or URL should have been correctly set (or communicated) by your
~ administrator while installing the feature; you should not have to change it.

Field Description

Host Name or URL Configuration with on-premises deployment
The name used to reach the on-premises Fax Server host.
Acceptable syntax: [ {http|https}://] <ServerName or IP>[: <Port>]

In HTTPS context, <ServerName_or_IP> must be the Common Name of the Fax Server
(and not its IP address).

Authentication

Option Description

Use Windows Integrated | If you wish to log in automatically with your current Windows Account.
Single Sign-On

Use Basic Authentication | If you wish to log in using your faxing account registered by the Fax Server ( User Name and
Password— with the option to remember your password).
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Web Phone Book

A Web Phone Book stores contact information about recipients to whom you are addressing faxes. This
information can include a contact’'s name, fax number, address, company and business address, etc.

There are two types of Phone Books:

» Public (corporate) Phone Book: assigned to you through your profile (accessible to all users having this
profile), and managed only by administrators.

» Personal (private) Phone Book: accessible and manageable only by yourself.
These phone books can mainly be used to address faxes from the Web Client — and optionally from SendFAX.
This chapter explains how to:

» Access and browse Phone Books.
+ Manage contacts and groups in your personal Phone Book.
+ Send faxes from Phone Books.

Access and Browse the Phone Books

To access the Phone Book management interface, login to the Web interface (see Logging into the Web
Client on page 81) and click the Contacts link located at the top of the page.

Personal Contacts & new |~ || #Edit | X Delete .. * | FA4Remove from ... ¥ ] Send Fax =] Import Contacts
B all Members =
> Show: u Select: All, None, Groups, Contacts
* Colleagues ‘ .4|:
e All Members (5)
Friends i Mo item is selected.
Company "Culleagues
& all Members * Friends
-,
e Management Jack Black
= Marketing Jane Dioe
R&D

Robert Pepper
5 Items

The interface is divided in three sections. The left column displays the list of available Phone Books (and their
groups) as the center column allows to browse through the contacts of a selected group. The right column
allows to view the information and details of a selected item.

g~ Note: Acondensed version of the information is displayed in the right section. Clicking Show full details
will make available the complete information of the selected item.

The Web Phone Book Search Tool

re Show: | Al A

You can search for items through the search bar located below the option bar by entering letters in the Search
members field. A search can be filtered by selecting a value in the Show dropdown list.

The Web Phone Book Quick Selection Tool

Select: All, Nene, Groups, Contacts
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If you need to quickly select multiple items, use the links available in the Select bar.

Contacts Management

Chapter 9 | Web Client

Within your personal Phone Book, you can:

» Create and manage your own contacts and groups

» Copy contacts from a public Phone Book to your personal Phone Book
» Import contacts from external sources

» Configure the automated adding of contacts

This section shows how to perform these actions.

Creating a Contact or Group

Creating a Contact

) E New
To create a contact, click = "%

Apply | Cancel Show Details ==
Contact Details

Display Mame™ |

Company

Fax

g~ Note: Only the Display Name and the FAX number are mandatory. If you wish to add more information
for the created contact you can access to a more complete input form by clicking Show Details >>:

Apply | Cancel << Hide Details
General Organization Information
Contact Name

Display Mame™ |
Contact Numbers

Phone

Pager

Cellular

FAX™

E-mail

g~ Tip: You can add a "+" sign in front of an international country code to apply the correct formatting to
the To: fax number on the Cover Sheet. However, the "+" sign feature may not be supported depending
on your phone company and/or the fax server configuration done by your administrator.

Click Apply to validate.
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Creating a Group

£ jew
To create a group, select Group by using the arrow beside the = =% putton.
Apply ||Cancel
New Group

Mame™: |

Enter a Name for the group and click Apply to validate.

Managing Contacts and Groups

Here is a list of the available options offered to manage contacts and groups in your personal Phone Book:

Button Description

P it Edits item details.

» Delete Deletes the selected item.

£ Andio v Adds the selected item to a group.

u Note: You can add a group to another group.

4 Remove from . = Removes the selected item from a group.

g~ Note: All the actions above can be performed on multiple selections (except Edit). However, they are
not available on public Phone Book items, as you can manage only your own contacts.

Copying Public Contacts to Your Private Contacts List

It is not possible to modify a contact in a public Phone Book. However, you can copy contacts from a public
Phone Book to your personal Phone Book in order to manage it as your other personal contacts.

Copyto ... =

For this, select an item, click . and select Personal Contacts.

g~ Note: This action can be performed on multiple selections.

Importing Contacts From an External Source

You can import an external contact list to your personal Phone Book by using a CSV file.

1. Select — in your personal Phone Book — the All members node or a group in which you wish to import
the external list of contacts.

2, Click +] Import Contacts
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Import Contacts

Only the CsY file format (Comma Separated Values) from the services listed below is supported for importing
contacts.
Select the service you are importing contacts from:

(@) Microsoft Outlook (using CSV) - EN

(_)Outlook Express (using CSV) - EN

()IBM Notes (using C5V) - EN

(") Microsoft Outlook {using CSV) - FR

(JIBM MNotes (using C5V) - FR

(") Microsoft Outlook (using CSV) - DE

()IBM Notes (using C5V) - DE

Choose the file to import
Browse...

Select the option for the contacts in the CSV file that may already exist: | Merge | v

Import Cancel

3. Select the type of application from which the contacts list to import was exported as a CSV file (MS Outlook,
Outlook Express or IBM Notes).

g~ Note: To use the IBM Notes (using CSV) option, the CSV file must have been exported from IBM
Notes version 8.5+, with the default parameters: all properties, with headers.

4. Browse for the file to import.

g~ Note: The file to import must be a CSV file exported by the application type selected above.

5. Select the option for contacts of the CSV file that would already exist in the Phone Book:

» Merge: The information contained in the imported contact will overwrite the existing contact.
» Add: A new contact will be created.
» Ignore: The imported contact will be ignored.

6. Click Import.

The contacts are now added to your Phone Book.

Sending a Fax From a Phone Book

To send a fax directly from a Phone Book:

1. Select a contact or group.

g Note: You can use here multiple selections.

Click ] Send Fax .
The Compose screen appears and the selected contacts are automatically added to the Recipients
section.

3. Compose the fax by following the usual procedure: Creating and Sending a Fax on page 110

Configuring Automated Adding of Contacts

A feature allows you to add new fax recipients to your Phone Book after a fax is sent. The way this feature
works can be configured.
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1. In the main screen of the Web Interface, click Options.
General Delegation
User Options

Interface Language: English v

Fax Download Format: FDF ¥

When sending a fax to new contacts
(@ Ask me if I want to add them to my Personal Contacts
(O) Add them to my Personal Contacts
(_) Do not add them to my Personal Contacts

Disable AutoComplete
Security

Change Password

Apply

2. Select an adding option in When sending a fax to new contacts:

+ Ask me if | want to add them to my Personal Contacts
+ Add them to my Personal Contacts
* Do not add them to my Personal Contacts

3. Click Apply.

Lexicon

ANI: Acronym for Automatic Number Identification. This is the sender's fax number (the FROM: field).

Broadcast ID: When sending to multiple recipients, OpenTouch Fax Center creates a Broadcast ID that will
be identical to all the faxes of the recipients (as opposed to the Transaction ID, which is different for each
fax).

Destination: The destination fax number (where a fax is sent). It appears in the Detail Properties of the
Outbound History and Outgoing Queue folders.

DID: Acronym for Direct Inward Dialing number. This is the recipient's fax number (the TO: field in the Inbound
History folder).

Extension: It will appear after the fax number in the Inbound History fax properties TO: field when used.
Fax ID: Represents Transaction ID or Broadcast ID.
Remote CSID: See Remote Fax Identifier CSID.

Remote Fax Identifier CSID: CSID is the acronym for Call Station ID. In an inbound fax, the Remote CSID
is the sender's identifier. It usually is a fax number but it can also be a string of characters.

Sender Billing Code: A code used by the sender to attribute the cost of the fax transaction to a specific
project or account.

Transaction ID: Unique identifier for each fax sent and received by OpenTouch Fax Center .
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